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GETTING STARTED

iPhoto ’o9, not iPhoto 8

Annoyingly, Apple refers to iPhoto ‘09
interchangeably as “iPhoto '09” and
“iPhoto8,” the latter of whichis the actual

version number. Although | prefer the
actual version numberto theyear, | fear it
would be too confusing tocall it iPhoto 8,
given that the previousversion, iPhoto7,
wasalso called iPhoto ‘08.As a result, I'll

use the iPhoto ‘09 name throughoutthis
book, except whenI'm referring to a very
specific version of iPhoto ‘09, such as the
current-as-of-this-writing iPhoto8.0.2.

12

Digital cameras have become commonplace,
andfew people even consider purchasing a
traditional analog camera anymore. But with
digital photos, the camerais only part of the
equation. Once you've taken photos, you
need software to help you import, organize,
edit, and share your photos. Since 2001, the
most popular application for that task on the
Machas been Apple's iPhoto.

But iPhoto’s popularity doesn’t stem just
from the fact that Apple bundles it—it’s a
genuinely useful program, providing a broad
set of features while remaining easy to use.
With iPhoto, you can organize your photos,
perform commonediting tasks, and create
professional-looking printed works (prints,
greeting cards, hardcover books, and even
calendars).

If iPhoto is so easy, why write this book?
Even thoughiPhoto ‘09 is the best version
of the program that Apple hasreleased so
far, it still doesn’t entirely demystify the
process of importing a digital photograph,
editing it, and presenting it on paper or on
the computer screen. And iPhoto comes
with no documentation beyond minimal and
often incomplete online help. Read on, then,
notjust for the manualiPhotolacks, but also
for the help you needto take digital photos
and make the most of them.

G4LYVLSDNILLID
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HARDWAREANDSOFTWAREREQUIREMENTS

Chapter 1

Hardware and

Software Requirements
iPhoto ‘09 hasfairly steep system require-
ments thanks to the resources needed to

work with large numbersofdigital images.

To run iPhoto, you need:

@ A Macintosh with a PowerPC G4

(867 MHzorfaster), PowerPC G5,or

Intel processor with 512 MB of RAM
(though 1 GB of RAMisbetter).
Realistically, the more CPU power and
RAM you can throw at iPhoto, the better
its performance. You'llalso find a large
monitor extremely helpful.

@ Mac OS X.Specifically, Mac OS X 10.5.6 or
later and QuickTime7.5.5 orlater.

¢ An optical drive that can read DVDdiscs,
since iLife (09 comes on DVD, Burning
DVDsdirectly from iDVD requiresa drive
that can write to DVD as well, such as an

Apple SuperDriveor a third-party DVD
burner.

# Asourceofdigital images, which could
be an iPhoto-compatible digital camera,
scanned images, Kodak Photo CDs, ora
service that providesdigital images along
with traditionalfilm developing.

VY Tips

@ Somefeatures—suchas Places; pur-
chasing print products; or uploading to
MobileMe,Flickr, and Facebook—require
an Internet connection. And you'rereally
going to wanta high-speed Internet con-
nection; dialup will be painful.

M On PowerPC G4- and some PowerPC

G5-based Macs, some slideshow themes

won't be available. See http: //support.
apple. com/kb/TS2576for details.

13

V More Tips

@ iPhoto can import photos in RAW format,
whichis an uncompressed imagefile
format used by some high-end cameras.
However, there are multiple flavors of
RAW,and iPhoto does not supportall
of them.

Someof the other components of
the iLife ‘09 suite, such as iMovie and

GarageBand, have steeper system
requirements. See www. apple. com/ilife/
systemrequirements.html for details.
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Getting Started

Acquiring iPhoto
Apple offers several methods of acquiring
iPhoto, althoughit’s worth noting that Apple
does not offer free upgrades between major
versions of the program.In other words,
even if you got iPhoto 6 bundled with your
last iMac, you muststill buy iLife ‘09 to get
iPhoto "09.

Waysto get iPhoto ’o9:

¢@ Look in your Applicationsfolder. If you
purchased your Macsince January 2009,
iPhoto ‘09 may alreadybeinstalled.

* Buy a $79 copy of Apple’s iLife '09, which
is a DVD package containingall five of
Apple’s digital hub applications:
iPhoto ’09, iMovie ‘09, iDVD 7,

GarageBand '09, and iWeb ‘09. Although
these applications comefree with new
Macs,the iLife packageis the only way
for current owners of iPhoto, iMovie,

iDVD, GarageBand, and iWebto get
updatesfor those products.Fordetails,
visit www.appLe.com/ilife/.

@ Buyanew Mac,which will come with
iPhoto preinstalled. Steve Jobs and his
private jet thank you!

V Tip

m@ Rather than buy multiple copies of iLife
‘09 to use onall the Macs in your house,
you can buy a $99 family pack that’s
licensed forupto five users.

OLOHd!DNININODY
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INSTALLINGiPHOTO

Chapter 1

Installing iPhoto
Installing iPhoto from theiLife ‘09 package
requires almostnoeffort at all. Be sure to
read “Updating to iPhoto '09” on page 6 too!

To install iPhoto:

1. Insert the iLife DVD into your Mac’s
optical drive.

N In the Install window that appears after
the DVD mounts, double-click theiLife

‘09 icon (Figure 1.1).

3. Click throughthe Introduction
(Figure 1.2), Read Me, License,
Destination Select (select your hard disk
here), Installation Type, Installation, and
Summary steps.

Whenyou're done, you end up with
iPhoto (and therest of the iLife applica-
tions) in your Applicationsfolder.

V Tips

@ The iLife installer won't allow you to
install if any ofthe iLife applications are
currently running; you must quit them
before installing.

m@ Ifyou don’t wantto install some of the
iLife applications (iDVD and GarageBand
in particular take upalot of disk space),
click Customizein the Installation Type
screen and select only the applications
you want (Figure1.3).

m@ Theinstaller calculates whetheror not

you have enoughdisk space;ifyou're on
the edge, install only iPhoto.

 
«

a a 09); S
: 3
gs fans etersYou inact   

Figure 4.1 Double-click the iLife ’o09 icon to start the
installation process.
 

 
Welcome to the iLife ‘05 installer

life “OS, a significant upgrade to Apple's suite of dipital ifestyle

 

© Intreduction shakes Ot eatier than ever to get The mast Out of yout
@tead Me photos, movies and music on your Mac. iLife ‘00 includes:
eo Lies _—— « Photo—Your phoros. By faces, places, anc event., . ecvbing. AMATINg Affects. Stunning simpEesty.oe « Gerageland—Create yout own song, Or learn to playone.

Secteiatiar y+ Web—-Enhanced websites and more aublishing options.@ brea a « IDVD—Holtywood-style DVDs made easy.
“a This instatlerquiges pau through the weps adcessary te install

@ Sar X tule. To get started, clack Continae
hon

FEr

fe te!   
(Gotack) CContie) Fl 

Figure 1.2 The Introduction screen describes the iLife
applications briefly. 

 
 

i ee —e =   
Coote) roel)

Figure 1.3 If you don’t want to installall the iLife
applications,click Customizein the Installation Type
screen and select only those you do want.

a
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Figure 1.4 Click Check Now to make Software Update
look for iPhoto updates. 

 Software Update

New software is available for your computer.
Wf you're mot ready to install now, you can Use the Software Update
preference to check for updates later.

Name
iDVD Update
iMovie Update
GarageBand Update

10.3 MB
18.4 MB 

This update addresaes lsawes encountered when moving photos between ised:plus new greeting card themes, including heliday card designs. ft also supper
-orciaatonamsi see, improves overall stability, and addresses a number ofevi

oe seo ilaerateeeinal Software License Agreement(s)that accompanied the software beinundated:Alstof Apple As maybe foundhere:

CGut)aD

  
A

Figure 1.5 To install an update, select the checkbox
next to its name, and thenclick the Install button.

Watching for Updates

Irecommendsetting Software Update
to check for updates automatically, and
iPhoto can dosoitself too (select Check

for iPhoto Updates Automatically in
the General pane of iPhoto’s Preferences
window). You canalsovisit Apple’s iPhoto
Webpage at www.appLe.com/ilife/
iphoto/ every so often for news about
iPhoto or updates that might not have
been released via Software Update.

16

Getting Started

Updating iPhoto
via Software Update
Although you can't get iPhoto ‘09 forfree via
Software Update, Apple will release minor
revisions via Software Update.

To update iPhoto via Software Update:

1. From the Apple menu, choose System
Preferences.

2. Todisplay the Software Update pane,
choose Software Update from the View
menu.

3. To check for updates, make sure you're
connected to the Internet, and then click

the Check Now button (Figure 1.4).

If Software Updatefinds any updates,
it launches another application that
displays updates that make sense for your
Mac,including iPhoto,if any exist.

4. Select the checkboxes next to the updates
you wantto install (Figure 1.5).

an Click the Install button, and when the

installer prompts youforit, enter your
administrator password.

Software Update proceeds to download
andinstall the selected updates.

V Tips

m Choose Check for Updates from the
iPhoto application menuat any time
to see if you have thelatest version.

m To set Software Update to kick in on
its own, select the Check for Updates
checkbox, and from the pop-up menu
choose how often you wishit to check.

m When Software Updatefails to find
updated software appropriate for your
computer,it tells you noneis available.

A1Vddf]JUVMLAOSVIAOLOH!ONILVGdf)
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UPDATINGTOiPHOTO’09

Chapter 1

Updating to iPhoto ’o09
In theory, updating from anearlier ver-
sion of iPhoto should be merely a matter of
installing iPhoto ‘09 andletting it upgrade
your iPhoto Library. However, a few simple
actions can prevent future problems.

Tips when updating to iPhoto ’o9:

@ Make sureto back up your iPhoto Library
(located in your user account’s Pictures
folder) before installing iPhoto 09. Then,
if something bad happens,orifyou need
to revert to yourearlier version for some
reason I can’t imagine, you won'tloseall
your photos. I’m sure you have a backup,
but another one can’t hurt.

¢@ Before updating your iPhoto Library, run
Software Update to make sure you have
the latest version of iPhoto '09.

¢@ Ifyou have installed third-party export
plug-ins (see “Other Web Export Tools,”
on page 145), it’s best to remove them
before updating(andtoinstall new ver-
sions that are confirmed to work with

iPhoto 09). To find them,(Control)-click
iPhoto’s icon in the Finder, choose Show

Package Contents, and navigate to the
Pluginsfolder. Drag any third-party plug-
ins to the Desktop.

@ Foraclean installation (and don’t bother

doing this unless you suspect trouble),
move the com.apple.iPhoto.plistfile (in
youruser account's Preferencesfolder)
andthe iPhoto application to the Trash,
but leave your iPhoto Library alone. Then
install iPhoto 09.

@ Ifyou have trouble immediately after
updating, delete the preferencefile men-
tioned in the previous tip and the iPhoto
application, and thenreinstall iPhoto ‘09.
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New Features in iPhoto ’o09

iPhoto ‘09 offers a number of welcome

enhancementsthat are covered through-
out this book. Here are my favorites:

@ iPhoto now boastsface recognition,
so you can organize your photos by
people whosefaces you've trained
iPhoto to recognize.

@ iPhoto can now read geotags, which
indicate the latitude and longitude at
which a photo was taken with a cam-
era (like an iPhone) containing a GPS
receiver. You canalsoassign locations
to photos that don’t yet have geotags.
Geotagged photos can be viewed on
a mapwithin iPhoto and included on
mapsin printed books.

@ A new Definitionslider in the Adjust
window improvesclarity and detail.

@ A new checkboxin the Adjust window
prevents the tools from oversaturating
skin tones as you makeother changes.

# An Auto buttonin the Red-Eye display
uses face recognition to removered-
eye automatically.

@ The Retouch tool now handles edges
and non-skin tonesbetter, and the

Enhancetool does a better job and
avoids oversaturating skin tones.

® Slideshows gain themes, use face
detection to keep faces onscreen, and
can be synced with an iPhone,iPod
touch, or Apple TV.

@ You can now upload photosto the
photo-sharingsite Flickr and the
social networking site Facebook.

@ Hardcover books ordered from Apple
can nowhave a photoonthefront
cover, as well as on the dustjacket.
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Your photo library will not be readable by previous
versions of iPhoto after the upgrade. The upgrade
process may take several minutes depending on the
number of photos in the library.

(Que) rand)

The photo library needs to be upgraded to
\ work with this version of iPhoto.

 

Figure 1.6 On the first launch with an old iPhoto
Library, iPhoto prompts you to upgrade the library.
Click Upgrade unless you wantto quitfirst and make
a backup before proceeding.

Recovering Photos on Upgrade

WheniPhoto 6 upgraded your iPhoto
Library, if it found photos that weren't
properly tracked in iPhoto’s database,it
offered to recover them, putting them in
an album called Recovered Photos.

[can’t be sure that iPhoto ‘09 will do the

same, having not seen this myself, but if
you are presented with such a message,I
strongly encourage you to heed it andlet
iPhoto recover the photos.

In somecases, the recovered photos may
actually be duplicates, at which point
you caneasily delete them. To figure out
whichare duplicates, search in iPhoto on
the filenameofthe photo(it’s usually the
sequential number assigned by your cam-
era). If only the recovered photo appears
in the search results, you knowit’s unique
and should be kept; if two or more photos

that are obvious duplicates show up, you
can probably delete any extras.

Getting Started

Launching iPhoto
Once you haveinstalled iPhoto, the next
step is to launchit. Thefirst time you launch
iPhoto differs from subsequent launches.

Waysto launch iPhoto:

¢@ Double-click the iPhoto icon in your
Applicationsfolder.

@ IfiPhoto’s icon already appears in your
Dock,click the Dock’s iPhoto icon.

¢@ Drag the iPhoto icon to your Dock to
add it to the Dock permanently, and
then click the Dock’s iPhoto icon.

@ Use a third-party launcherutility like
LaunchBar.I really like LaunchBar, and
you can find more aboutit at www. obdev.
at/products/Launchbar/.

iPhoto’s initial launch

The first time iPhoto '09 launches and sees

an iPhoto Library created with a previous
version of iPhoto, it prompts you to upgrade
it (Figure 1.6). Click Upgrade to proceed
(this can take quite sometime, depending
on how manyphotosyou havein your iPhoto
Library), or click Quit ifyou want to make a
backupfirst.

V Tips

@ Youcan putoff the decision to make a
backuporuse a different iPhoto Library,
but upgradingisn’t optionalifyou wish
to use photosin your existing iPhoto
Library with iPhoto 09.

@ Don'tinterruptthe relatively slow
upgrade processor workin other iLife
applications while it’s upgrading.

OLOHd!DONIHINNV]
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iPHOTO’SMODES

Chapter 1

iPhoto’s Modes

Whenyou use iPhoto, you'll find yourself
in one of five modesatall times. Therest of

the book looks at these modes, focusing on
the tasks you perform in each mode. Here’s
a quick summaryofthe modes.

Import mode

To add photosto your photolibrary, you
import them,either from files or from a digi-
tal camera. All you can do in import modeis
select which photos to import, but note that
you can keep workingin otherparts of the
program while iPhoto imports photos.

Organize mode

Once you have imagesin iPhoto, you'll want
to organize them into events and albums,
assign them keywords,and delete the lousy
ones. All that and more happensin organize
mode, where you'll spend mostofyourtime.

iPhoto’s organize modealso provides tools
for running slideshows, creating Web pages,
setting your screen saver and Desktop
picture, sending photos via email, exporting
photos, and more.

Faces mode

Newin iPhoto ’09 is Faces mode. When you
teach iPhoto to recognize a person'sface, the
controls changeto focus on that task, with
screens and controls for identifying faces
in photos, confirming that the face iPhoto
has identified in other photosis correct, and
browsing throughidentified photos.

Places mode

Also new in iPhoto ‘09 is Places mode, which

provides controls for showingthe locations
of geotagged photos on a mapor displaying
the photos takenin a particular location.

Edit mode

Eventhe best photographersedit their
images. iPhoto provides the basic image-
editing tools you need to crop pictures,
enhancecolors, removered-eye, retouch
unsightly blemishes, and applya variety
ofeffects.

iPhoto also provides more advanced edit-
ing tools that let you adjust exposure,play
with the colors in your photo,and straighten
photos, amongotherthings.Ifyou need even
more advancedtools or tools that let you
work on only selected portions of a photo,
iPhoto can work with another imageeditor,
such as Adobe Photoshop Elements.

Slideshow mode

With iPhoto’s powerful slideshowtools, you
can create highly customized slideshows
containing music, elegant transitions, per-
slide timings, and the Ken BurnsEffectfor
panning and zoomingphotos. Once you
create the slideshows, you can replay them
as many timesas youlike; export them to
QuickTime movies that you can share with
yourfriends andrelatives; or even sync them
with an iPhone, iPod touch, or Apple TV.

Book/calendar/card/print mode

Oneof iPhoto’s great strengths is the way
it helps you design and orderprofessional-
looking books, calendars, and cards. All
those tasks take place in very similar modes
with controls dedicated to the task of design-
ing pages.

You're not limited to buying things from
Apple; iPhoto also provides theme-based
printing that uses a similar interface to help
you create and print photo designs on your
own printer.
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Source pane.
Create and work Drag to
with albums, resize the
folders, Web gal- Information
leries, books, pane.
calendars, cards, |

and slideshows |
here. Cameras and |
card readers also | Drag to
appear here when | resize the
importing. | source pane.

Information
pane. Info
aboutevents,
images, and
albums shows

up here.

Click to enter

full-screen
editing mode.

Click to add
an album or

other project.

Click to hide
or show the

Getting Started

Interface Overview

Before we dive into the specifics of using
iPhoto in the upcomingchapters,let's take
a bird's-eye view of the main window so you
can orient yourself and geta feel for the
program's primary functions (Figure 1.7).

l assumeherethat you already know about
standard Mac OS X window widgetslike the
close, minimize, and zoom buttons, the scroll

bars andscroll arrows, and the resize handle

in the lowerright. If not, let me recommend
that you visit your local bookstore and look
for a beginnertitle that will help you with the
basics of Mac OS X,

Display pane. Your events and images
shawup here ina variety ofsizes, as
do thumbnails ofbook, card, calendar,
andprint pages you create.
 

  
Information ~~
pane.

Search bytitle, keyword,
date, or rating (choose
from the pop-up menu).

Figure 1.7
fo

 
Numberofevents
and photosselected. "Bis

Click to play a basic
slideshow with the

selected photos.
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The controls available here

change with your current
mode (organize mode shown). orout.

Event names (shown
here) or phototitles,
ratings, and key-
words appear below
the images.

Size slider. Adjust
this slider to resize

the contents ofthe
display pane. In
organize mode, the
slider displays more
or fewer thumbnails;
in edit and book

mode, it zooms in

M4IAYMSAQJDVINSLN]
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IMPORTING AND  
MANAGING PHOTOS

Multitasking While Importing

You maynotrealize it, but you can work
in other parts of iPhoto whileit is import-
ing images. Althoughthis is worth keep-
ing in mind,it’s not always as much of a
help as you mightthink, since you usually
wantto work with the imagesthat are
being imported.

22

Oneof the most commonthings you'll find
yourself doing in iPhoto is importing photos.
iPhoto provides a numberofways you can
import photos, including the most obvious:
from a digital camera or iPhone.

You can also import files that you down-
loaded from your camerapreviously,
acquired on a CD, scannedin from prints,
downloaded from the Internet, or received

from a photo-processing companythat
providesdigital images along withtradi-
tional prints.It’s also possible to use a card
reader—a USBor FireWire device into

which you put the memory card from your
camera and which presents the contents of
your memory cardasfiles on a disk—with
the twist that iPhoto recognizes manycard
readers and can import from them justas
though they were cameras. Andlastly, you
can copy photos that other iPhoto users
make available to you on disc or over a
network.

In this chapter, we'll look atall the ways you
can import pictures into iPhoto and man-
age them afterward,including such tasks as
trashing and recovering photos, making and
switching between different iPhoto libraries,
backing up your images to CD or DVD,and
learning exactly how iPhotostores images on
your hard disk.

11
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ENTERINGIMPORTMODE

Chapter 2

Entering Import Mode
It’s easy to bring your photos into iPhoto no
matter where they mayoriginate because
iPhoto offers four different importing
approaches,all ofwhich switch you into
import mode automatically. The only
time you needto switch into import mode
manually is ifyou switch modesafter
connecting a camera but before clicking
either Import Selected or Import All.

Waysto enter import mode:

* Connect your digital camera to your
Mac’s USBport and turn the camera on.
iPhoto need not be running;it launches
automatically if necessary (Figure 2.1).

@ Insert your camera’s memory card into
the card reader. iPhoto need not be

running;it launchesifnecessary.

@ From iPhoto’s File menu, choose Import

to Library ((CmaJ(Shift{1)). iPhoto displays
an Import Photos dialog from which you
canselecta file, a folder, or multiple items
before clicking Import.

@ From the Finder, drag and drop one or
morefiles or an entire folder of images
into the iPhoto windoworonto the

iPhoto icon in the Dock.

V Tips

@ The Last Import album in the Recent
list remembersthelast set of images you
imported.Click it to see just those images
(Figure 2.2),

m By default, iPhoto showsyouall the pho-
tos on yourcard, but ifyou have already
imported someof them,select Hide
Photos Already Imported to avoid seeing
the already imported photos,

12
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Figure 2.1 After you attach a camera or insert a media
card, it shows upin the source pane, and thumbnails
of its pictures appear in the display pane.

 
Figure 2.2 To see thelast set of images you imported,
click the Last Import album in Recent.

Launching Automatically

iPhoto launches automatically only ifyou
allow it to do so. Thefirst time iPhoto

runs,it asks ifyou wantit to launch
automatically from thenon.Ifyou agree,
iPhoto takes over as the application that
launches when you connect a camera. You
can changethis setting in iPhoto’s General
preferencepane,ifyou wish.
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Figure 2.3 Click either Import Selected or Import All
to import photos from your camera.
 

  
Figure 2.4 While iPhoto imports photos,it displays
the image being downloaded along with a progress
bar. To stop the process beforeit completes, click the
Stop Import button.

 
 

_ Delete Photos on Your Camera?

i 12 photos weresuccessfully imported into iPnoto.

(KeepProtos)  
Figure 2.5 When iPhotofinishes importing,it gives
you the choice of keeping or deleting the original
photos on the camera. | recommend keeping them
and deleting them later from the cameraitself.

Importing and Managing Photos

Importing from a Camera
Mostpeople will probably import most of
their photosdirectly from a digital camera.

To import from a digital camera:

1.

3.

Connect your camera to your Mac using
the USBcable included with the camera,

turn it on, and makesure the camerais

set to view pictures.

iPhoto switches into import mode
(Figure 2.1, previous page).

Either select one or more photos to
import and click ImportSelected, or
click Import All (Figure 2.3).

iPhoto imports the photos, showing
thumbnailsas it works (Figure 2.4). If
you've made a mistake, click Stop Import.

iPhotoasks ifyou'dlikeit to delete the
original photos from the cameraafter
importing (Figure 2.5).

Click the Keep Photos button.

V Tips

To be safe, alwaysclick Keep Photos.
Thenerase the card in your cameraafter
verifying that the import succeeded.

You can nameanddescribe the event that

will be created by the import. The name
and description are applied only to the
first event if more than one are created.

Select Autosplit Events After Importing
unless you're importing photos from one
event that spans multiple days.

Ifyou attempt to import an already-
imported photo,iPhoto asks ifyou want
duplicates or only new images.

Some cameras mount on your Desktop
like a hard disk. Eject such a camera using
the eject button next to its namein the
source panebefore disconnectingit!

13
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IMPORTINGFROMACARDREADER

Chapter 2

Importing
from a Card Reader

Importing images via a memory card reader
works almost exactly like importing from a
digital camera.

Eject
button.

4 Figure 2.6 Be sure to
| click the eject button

next to the card’s
namein the source

pane before remov-
ing the card.

To import from a card reader:

1. Connect your card reader to your Mac
using USBor FireWire, as appropriate.

 
2. Insert your memory card.

iPhoto switches into import mode.

3. Either select one or more photos to
import andclick Import Selected, or
click Import All.

iPhoto starts importing the photos.If
you've made a mistake,click the Stop
Import button. iPhoto then asksifyou'd
like it to delete the original photos from

 
the card after importing. Figure 2.7 For a quick glance at a photo on a memory

card, make sure you're in column view, navigate to
4. To remove the memory card from the where the imagesare stored, and select one to see a

card reader,first click the eject button preview. Orjust select it and press the Space bar to
next to the card’s name in the source use Quick Look.

pane, and theneject the card from the
card reader(Figure 2.6). Kodak Photo/Picture CD

V Tips iPhoto can importdigital images from
Kodak Photo CDs and Picture CDs, which

m@ Whenusinga card reader, you may be you can get when havinganalogfilm
able to preview yourpicturesin the developed. Insert the CD and iPhoto sees
Finder's columnview,or using Mac OS X’s it as thoughit were a memory card.
Quick Look feature by selecting the photo
andpressing (Figure 2.7).

m Youcandragfiles from the card into
iPhoto to import them manually. Ifyou use a MacBookPro or PowerBook

with an ExpressCard or PC Cardslot,
you can buy an adapter for your memory
cards, Then, instead of mucking about
with a bulky USB card reader, you can
insert your memory cardinto the credit
card-sized adapter, and then insert the
adapter into the laptop to import the
photos on the memory card.

Laptop Memory Card Adapters

@ Nevereject the card while importing!

14
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Source

pane. 
 
  
 
 

Figure 2.8 The easiest way
to importfiles into iPhoto is
to drag the desiredfiles or
folders into the display pane
or the source pane,as I’ve
donehere.

 
THF imageBreazed Cepeda a 14 OWMeatRetWavtersiay at 3°50 FmLake epeeed Wvterday at tt oeDemeneene

 

  
Maree 

= Cray Caratuae toro ie

 
Figure 2.9 To import existing image files into iPhoto,
choose Import to Library from the File menu, navigate
to your images, select the desired files, and click
Import.

 

SupportedFile Formats

iPhoto can import imagesin anyfile
format supported by Apple’s QuickTime
technology, including BMP,GIF, FlashPix,
JPEG, MacPaint, movies (read-only), PICT,
PNG, Photoshop, RAW (thoseflavors
supported by MacOSX in general), SGI,
Targa, and TIFF.

Importing and Managing Photos

Importing from Files
Ifyou have photosalready on yourdisk,orif
someone gives you a CD or DVD of photos,
iPhoto can importthesefiles in several ways.

Waysto import files into iPhoto:

¢@ From the Finder (or some photo catalog-
ing applications), drag the desired files
or folders into iPhoto’s display pane or
source pane (Figure 2.8).

@ From the File menu, choose Import
to Library ((CmaJShift(1)). In the Import
Photosdialog, navigate to your images,
select the desired file(s) or folder(s), and
click Import (Figure 2.9).

With either approach, iPhoto starts
importing the images.Ifyou wantto halt
the import, click Stop Import. When the
import finishes, the photos appearin the
display pane.

V Tips

@ Hold down or to select

multiplefiles in the Import Photosdialog.

m By default, iPhoto copiesthe files you
import, so make sure you have enough
hard disk space beforestarting.

@ Ifyou dragafile or folder onto the
Albumslist in the source pane, iPhoto
imports the photos and creates an album.

@ Youcandrag photosinto a specific
album, Web album,book,calendar, card,

or slideshow to import and add the pho-
tos to that collection.

@ iPhoto retains the EXIF camera

information stored with images along
with filenames you've given the images.

m@ iPhoto creates a new event for each

import. Events created from folder
imports pick up the nameofthefolder.

15
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IMPORTINGFROMMAIL,SAFARI,ANDOTHERS

Chapter 2

Importing from Mail,
Safari, and Other Apps
Manypeople share photosvia the Internet,
either sending them via email or posting
them on Webpages. The details vary by
application, but one of these techniques
will always work.

To import from Mail:

@ Click the Quick Look button in the

message headerto view the photo(s)
(Figure 2.10) and then click the Add
to iPhoto button (Figure 2.11).

@ Drag the photo to iPhoto’s source pane or
display pane.

To import from Safari:

@ (Conirol|-click the image in Safari and
choose Add Imageto iPhoto Library from
the pop-up menu(Figure 2,12).

To import by dragging:

@ From applications such as Eudora that
identify dragged data appropriately, drag
the photo to iPhoto’s source paneor dis-
play pane.

To import by saving, then dragging:

@ From applicationslike Firefox that
don’t allow direct dragging into iPhoto,
(Control-click the image, use oneof the
commandsin the contextual menu to

save it, and then dragit from the Finder
into iPhoto.

Vv Tip

m There's no way to know in advanceif an
application will allow direct dragging into
iPhoto,like Eudora,or not,like Firefox.

Trial and erroris the only way.
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From: Adam Engst

| Subject: That photo of T
Date: October 9, 2007 11:26:11 AMEDT

Te: Adam Engst
» # 1 Atlachment, 75.5 KB (alee) (GuleiLaok)

Figure 2.10 To view and import photosin a Mail
message, click the Quick Look button in the header.

Addto iPhoto

Jon pal
Figure 2.11 Click the Add to iPhoto button to add the
photo to your iPhoto library.

 
 

Openin Dashboard...

Save Image to "Downloads"
Save Image As...
Add Image to iPhoto Library
Use Image as DesktopPicture
 

Copy Image Address
Copy Image

Inspect Element 

Figure 2.12 In Safari, Control-
click a photo and choose Add
Image to iPhoto Library to, well,
add it to your iPhotolibrary.
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Figure 2.13 iPhoto discs appear
in your source pane with any
albums on the disc showing up
under the disc name.

 
Figure 2,14 The easiest way to import pictures from
an iPhotodisc into iPhoto is to drag the desired
photosinto the source pane,as |’ve done here.

No Keywordsfrom iPhoto 5

Unfortunately, iPhoto 5 did not save
keywords when burning to an iPhoto
disc, which makes importing from an
old backupdisc less desirable ifyou've
put mucheffort into keywords. Luckily,
later versions of iPhoto fix the problem,
including keywords on iPhoto discs and
importing them along with photos.

28

Importing and Managing Photos

Importing
from an iPhoto Disc

iPhoto helps you protect your photocollec-
tion by making backupcopies to CD or DVD
(see “Backing up Your Photos,” on page 26).
Should something go wrong with your main
iPhoto Library, you can restore your photos
from these backupdiscs.

Also, friends or relatives who use iPhoto

might send you discs of photos; although you
can view photosfrom thedisc,ifyou want to
edit a photo or create a book, you mustfirst
import the desired images.

To import from an iPhoto disc:

1. Insert the iPhoto disc into your Mac’s
optical drive and switch to iPhoto.

iPhoto displays the disc in the source
pane under Shares (Figure 2.13),

2. Select one or more photosor albums,
and then drag them to the source pane to
import them into the iPhotolibrary and
create an untitled album (Figure 2.14).
Alternatively, drag them into an album
to import them and add them to that
album.

iPhoto starts importing the photos,
showing the images and a progressbar.
Click Stop Import to halt if necessary.

V Tips

m@ Importing from an iPhoto disc works
almost exactly the same as copying
photos from a shared photo album.

@ iPhoto performs duplicate checking, just
as with the other import methods.

m Dragginga disc’s album to the source
panecopies the album to your iPhoto
Library.

17
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IMPORTINGVIAIMAGECAPTURE

Chapter2

Importing via
Image Capture
Before Apple released iPhoto, the way you
transferred imagesfrom a digital camera to a
Macrunning MacOS X waswith an included
utility called Image Capture (found in your
Applicationsfolder). Image Captureisstill
useful for downloading images from your
cameraifyou don't want them to go into
iPhoto for some reason.

To import using Image Capture:

1. Launch Image Capture.

2. Connect your cameraor insert a memory
card into your card reader, as appropriate.

3. Either click DownloadAll (Figure 2.15),
or click Download Some,select several

photos to import, and click Download
(Figure 2.16).

Image Capture imports the photos to
your Pictures folder as normalfiles.

VY Tips

m Youcan download photosto any folder
using Image Capture. Choose Other from
the Download To pop-up menu,and then

select the desired folder in the dialog.

@ To adjust Image Capture’s options, click
the Options button in Image Capture’s
main window.In particular, make sure
it doesn't delete after downloading for
safety’s sake. It’s always best to erase pho-
tos in your camera after you're sure they
have imported properly (Figure 2.17).
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 Download To:(Pears,MovesandMasefolders|_| Automatic Task: { None ie

‘Occurs after downloading
hems to download: 1200

crLe)

Figure 2.15 To download photosvia Image Capture,
connect your camera or insert your memory card,
open Image Capture, and click Download All.
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Figure 2.16 Alternatively, to import only particular
photos,click Download Some,Shift- or Command-
click to select a set of desired images in Image
Capture’s thumbnail listing, and then click the
Download button.

 
Information

(ACreate custom icons
‘Add iteminfoto Finder filecomments

{)Automatically download all items

an)2

Figure 2.17 Make sure to set Image Capture’s options
so photos aren’t deleted from the camera or card,
both for safety’s sake and in case you also want to
import into iPhoto.
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structure that starts in your Pictures folder.

Old Stuff That Can Go

Although you shouldn't messwith files
andfolders in the iPhoto Library package
generally, there are a few items you can
delete without harm—ifthey're present—
because they'rerelics from previous
versions and are no longer used. You likely
won't save muchdisk space by deleting
these unused items, but sometimesit’s

nice to have things be a bit moretidy.

Starting with iPhoto 6, the structure of
the iPhoto Library changedsignificantly.
Previousversionsof iPhoto used a year/
month/day hierarchy offolders, storing
originals and modified imagesseparately
within thefinal day folder. If there were
errors in upgrading yourlibrary when you
first launched iPhoto6, those year folders
maystill exist at the toplevel. As long as
you allowed iPhoto to recover the photos
nested inside, you can deleteall the year
folders with impunity (it’s worth checking
inside each onefirst, of course).

Other items you can delete include the
Desktop, iDVD, and Screen Effects fold-
ers. These folders merely contain aliases
used by previousversionsofiPhoto for
your Desktoppicture, iDVD, and the Mac
OS X screen saver.

30

Importing and Managing Photos

iPhoto Directory Structure
iPhoto createsits entire directory structure
in the Pictures folder inside your user folder,
starting with a package (a specialfolder you
can’t open normally) called iPhoto Library.
Inside it, iPhoto creates three specialfolders:
Originals, Modified, and Data. Inside each
are folders for years; inside those are folders
correspondingto events, and inside those
event folders you finally get to the actual
imagefiles (Figure 2.18).

The top-level Originals folder contains your
original photos. The Modified folder con-
tains, in its event folders, modified versions

ofyour photos. Until you make a change to
an original image, there won't be a cor-
respondingfile in the Modified folder. The
Data folder holds thumbnail images of your
photos; they look the samein the Finder's
preview, but are much smaller insize.

V Tips

m To openthe iPhoto Library package,
(Control)-click it and choose Show Package
Contents.

@ Other than the items mentioned in “Old

Stuff That Can Go,’ do not move, rename,

or delete anythinginside the iPhoto
Library in the Finder because you'll risk
confusing iPhoto and corrupting your
library! (And always work with a backup!)

m Ifyou ever have to recover your photos
from a corrupted iPhoto Library package,
look in the Originals and Modified fold-
ers. Originals contains the photos as you
imported them and Modified contains
the versions that you edited.

m To locateafile corresponding to a photo
in iPhoto, (Control)-click it in iPhoto and
choose ShowFile. If you have edited the
file, you can choose Show Original File to
display the originalfile in the Finder.

i9
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LEAVINGPHOTOSINPLACE

Chapter 2

Leaving Photosin Place
Since iPhoto 6, iPhoto has had the capability
to import photosfrom the Finder without
copyingtheoriginalfiles into the iPhoto
Library package. The lack of this feature in
early versions of iPhoto drove some users
nuts, since they werent sure they trusted
iPhoto to manageall their laboriously
arranged photos.

iPhoto nowprovides a simple checkbox
in the Advanced paneofits Preferences
window:Copy Itemsto the iPhoto Library.
Uncheck this checkbox (Figure 2.19), and
iPhoto will create aliases to your original
photosin the Originals folder, leaving the
original files whereverthey're located on
your hard disk.

Honestly, | generally don’t recommendusing
this feature because it separates youroriginal
photos from the modified versions that
iPhoto creates, which could cause confusion,

particularly with backups. It might have been
useful in iPhoto 1.0, but at this point, the fea-
ture is simply unnecessary for most people.

V Tips

@ Turning off Copy Itemsto the iPhoto
Library has no effect on photos imported
from camerasor card readers.

@ Whenyouedit a photo, iPhoto stores
the edited version in the Modified folder,

just as you'd expect. But the changes you
makeare notreflected in the version

stored outside of your iPhoto Library.

@ To locateafile corresponding to a photo
in iPhoto,(Control}-click it in iPhoto and
choose ShowFile. Ifyou have edited
thefile, you can instead choose Show
Original File to display the originalfile in
the Finder.
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Importing: MM Copy items to the iPhoto Library

Mi Embed ColorSync profile
Cole Orofiles cannot be emocdded ifthe ems are not copied inte the iPhota
Library.

RAW Photos: [7] Use RAW when using external editor
1) Save edits as 16-bit TIFF files

Look up Places:|Automatically 

Figure 2.19 Uncheck Copy Items to the iPhoto Library
to leave photos imported from your hard diskin their
original locations.
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Are you sure you want to delete the
| 573 items permanently?

You cannot undo this action.

(Cancel) (GOK)  
Figure 2.20 iPhoto checks to make sure youreally
want to delete photos from your hard disk before
doing so.
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Deleting Photos
Many of the pictures any photographer takes
are lousy, and you needto cull the ones of
your spouse wearing a stupid expression.
Believe me, you really do. But that’s the best
part of digital photography; there’s no cost to
taking a photo andtrashingit immediately.

You can trash photosonlyifyou're viewing
photosin Events, Photos, Last Import, or
Last 12 Months, and notin a normalalbum.

Waysto trash photos:

# Select one or more photos(see “Selecting
Photos,” on page 45), and press(Delete],
drag them to the Trash album,or
(Control)-click the selection and choose
Move to Trash from the contextual menu

that appears.

¢@ While viewing a photo from Events,
Photos, Last Import, or Last 12 Months
in a basic slideshow orin edit mode,

press(Delete).

To delete photos for good:

1. From iPhoto’s application menu, choose
Empty iPhoto Trash ((GmaJShift|(Delete)).

iPhotoasksifyou really want to remove
the pictures (Figure 2.20).

2. Click OK to delete the photos.

V Tips

@ Deleting a photo from a normal album (or
book,calendar,card, or slideshow) does

not delete the original image but removes
it from that album.

m@ The only way to remove a photo from
asmart album is to change the photo's
criteria so the smart album doesn't seeit.

@ Dragging a photo to the Trash icon on the
Dock does nothing.

m Remember, backupsare your friends!
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CULLINGPHOTOSQUICKLY

Chapter 2

Culling Photos Quickly
Now that you know howto delete photos,
you need to learn howto delete them as
quickly and effectively as possible. There
are four waysto cull photos, but the best

approachisn't necessarily the most
obvious. In order of worstto best...

Waysto cull imported photos:

In organize mode, use thesizeslider to
zoom your thumbnails, then click each
one you wantto delete and press(Delete).
Because this method requires so much
clicking,it’s clumsy.

@ Select up to eight photos and choose
Full Screen from the View menu

((Cma)(Option|[F)) to enter full-screen mode
with the photos showingat the largest
possible size (Figure 2.21). Click a photo
in full-screen modeto select it, and press

to trash it. Cycle through photos
by pressing the arrowkeys. This method
workswell for comparing similar photos
but doesn’t display the photosaslarge as
whenyou view them oneat a time.

@ Inorganize mode, magnify a photo by
double-clicking it (or (Option|-double-
clicking it, dependingonthesetting in
iPhoto’s preferences), then cycle through
the photos with the arrowkeys, pressing

to trash those youdon’tlike.

¢ Inediting mode, eitherfull-screen or
in iPhoto’s display pane, cycle through
the photos with the arrowkeys, pressing

to trash those you don’t like (see
full instructionsin the sidebar).

Vv Tip

m Youcan nolonger delete photos while
viewing themin a slideshow. Don’t fret—
it wasn't a good method before anyway,
due to the lack of Undo support.
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Figure 2.21 In full-screen mode, you can compare up
to eight photos; click any one to selectit, and send it
to the Trash by pressing Delete.

The Best Wayto Cull Photos

So youve just imported a bunch of photos
and you wantto getrid of the worthless
ones. Here's my favorite method, which
can be doneentirely from the keyboard
and showseach photoatfull size.

1. Switch into full-screen modebyselect-
ing thefirst photo in the event you
want to clean up andclickingthe full
screen button or choosing Full Screen
from the View menu([Gmd}[OptionF)).

Ifnecessary, rotate the image to the
correct orientation with (Cma]R] or

(Cmd|(Option\[R). You can also do other

minoredits at this point, but don't get
bogged down.

ly

3. Ifyou likeit, press(3)(the right arrow
key) to move on to the next photo.

4. Ifyou don'tlike it, press to move
it to the Trash and moveon to the

next photo automatically. Ifyou delete
a photo accidentally, press to
bring it back.

5. Repeat steps 2—4 as necessary.
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Cut

Copy
Paste

Edit

Edit Using Full Screen
Edit in External Editor

Rotate Clockwise
Rotate Counter Clockwise

Get Info
Show File

ShowOriginal File

Batch Change.

Duplicate Figure 2.22 To
remove photos from
the Trash, select

My Rating >

Make Key Photo

Importing and Managing Photos

Recovering Photos
iPhoto sports a special Trash album that
holds all your deleted photos,just like the
Finder’s Trash. Andlike the Finder's Trash,

you can pull mistakenly deleted photosout.

Waysto recover photos:

@ Select one or more photos in the Trash
album and chooseRestore to Photo

Library ((Cmd)(Delete}) from the Photos
menu(Figure 2.22).

# Select one or more photosin the Trash
album,(Conitrol]-click the selection, and

 
Hide Photo

 Restore to Photo Library ..

Revert to Original "

 
them and choose
Restore to Photo

Library from the
Photos menu.

choose Restore to Photo Library from
the contextual menuthat appears.

Use YourTrash!

I strongly recommendthat you makefull
use of iPhoto’s Trash and empty it only
occasionally. The whole point of having a
Trash is to save you from mistakes, and
you never knowifyou'll realize a mistake
right away. Instead, let photossit in the
Trash for a while before deleting them for
good. Or wait until you feel like you need
the disk space they take up before delet-
ing them.

# Drag one or more photos from the Trash
album onto Events or Photosor,ifyou
wantto create an album from the recov-

ered photos, to the Albumslist in the
source pane.

V Tips

@ Youcan’t magnify or edit photos stored
in the Trash, nor can you create a book,
calendar, or card using the Trash album.
Well, duh!

m@ You can’t drag a photo from the Trash
album into another album withoutfirst

restoringit.

m iPhoto doesn't movethe actual image
files when you put them in the Trash;it
merely tracks which onesare in the Trash
album. Only when you empty the Trash
are the actualfiles deleted.
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CREATINGMULTIPLEiPHOTOLIBRARIES

Chapter2

Creating Multiple
iPhoto Libraries

Althoughthere'slittle outward indication
of this, iPhoto lets you create and maintain
multiple iPhoto libraries.

Reasonsto create

multiple iPhoto libraries:

# You might want to keep twodifferent
types ofphotos completely separate, such
as personal snapshots andlocation shots
for yourreal estate business.

@ You might want different iPhoto librar-
ies for different purposes. For instance,I
have a special iPhoto Library that holds
a small set of specific images that I use
whengiving presentations.

@ You might want an iPhoto Library
for miscellaneous photos sent to you
by other people that you don’t want
cluttering your maincollection.

To create an iPhoto Library:

1. Quit iPhoto.

2. Hold down andclick iPhoto’s icon

in the Dockto launchit.

In the dialog that appears,click Create
New (Figure 2.23), and in the save dia-
log, enter a name andselect a location for
your newiPhotoLibrary (Figure 2.24).

Vv Tip

m Ifyou want a second iPhoto Library to
contain all your photosto start with,
select the original iPhoto Library pack-
age in the Pictures folder in the Finder
and choose Duplicate ((Cmd{D)) from the
Finder's File menu.
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i What photo library do you want IPhoto to use?
, You can select a photo library from the list, find another library on

your computer, orcreate a new library that you can import photos
to later, The samephoto library will be used the next time youiPhoto,

iPhoto Library Demo
iPhoto Library Oneonta

esey Test 
jUsers/adam/Pictures/iPhose Library

( Other Library...) (Create New.) (€hease-)

Figure 2.23 Create a new iPhotoLibrary by holding
down Option while launching iPhoto and then clicking
Create Newin the dialog that appears.
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Figure 2.24 Name and save your new iPhoto Library
however and wherever youlike.
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_ Do you want to switch the current iPhoto Library
\ from “iPhoto Library” to “iPhoto Library Test” andrelaunch iPhoto?

Figure 2.25 If you double-click an iPhoto Library
package in the Finder while iPhoto is running,click
Relaunch to switch from the current library to quit
iPhoto, and switch to the selectedlibrary.
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Figure 2.26 iPhoto Library Manager enables you to
switch among multiple iPhoto libraries easily.
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Figure 2.27 You can also use iPhoto Buddy to switch
among multiple iPhotolibraries.

Importing and Managing Photos

Switching between
iPhoto Libraries

So you now havetwo(or more) iPhotolibrar-
ies. How do you switch between them?

Waysto switch
between iPhoto libraries:

@ Double-click an iPhoto Library package
in the Finder.IfiPhoto is not running,it
launches and opens the iPhoto Library
youclicked.If it is running,it asks youif
you want to switch (Figure 2.25).

@ Hold down andclick iPhoto’s icon

in the Dockto launchit. In the dialog
that appears,click Choose (Figure 2.23,
previous page), and locate the desired
iPhoto Library.

@ With iPhoto not running, manually
renameor move your main iPhoto
Library package, then rename or move
the desired iPhoto Library packagesoit’s
called just “iPhoto Library” andis located
in your Pictures folder. Ifyou launch
without renaming,orif the name doesn't
match exactly, iPhoto prompts you to
choose a photolibrary (Figure 2,23,
previous page).

@ Use Fat Cat Software's $19.95 iPhoto

Library Manager, with which you can
managethe iPhoto libraries you want to
switch among (Figure 2.26). Findit at
www. fatcatsoftware.com/ipIm/. iPhoto

Library Manager can also copy photos
betweenlibraries,split large libraries,
mergelibraries, and much more.

@ Use Rick Neil's free iPhoto Buddy
(www. iphotobuddy. com), which also
provides a simple interface for switching
quickly amongmultiple iPhotolibraries
(Figure 2.27).
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BACKINGUPYOURPHOTOS

Chapter 2

Backing up Your Photos
The most important thing you can do when
managing your photos is to make a backup.

To back up photos:

1. Select the items you want to back up,
whichis best donebyselecting events in
the display pane (Figure 2.28), or fold-
ers, albums, books, calendars, cards, or

slideshowsin the source pane.

2. From the Share menu, choose Burn,

insert a blank disc, and click OK.

Below the display pane, iPhoto shows the
nameof the disc and information about

how muchdatawill be burned to the disc

(Figure 2.29). The disc’s icon will be red
if it can’t hold the selected photos.

3. Select fewer or more photosto use the
space on yourdestination disc as desired.

4. Change the nameofthe disc if you want.

5. Wheneverythinglooksright, click the
Burn button to start the burn, and when

iPhoto asks you to confirm onelast
time andlets you set additional burning
options, click Burn (Figure 2.30).

iPhoto creates a disk image, copies the
selected photostoit, and burns thedisc.

V Tips

@ Don'tbelieve statistics reported about the
size of the selection in the Information

pane; the only numbers that matter are
those that iPhoto reports in step 2 above.

m@ Onthedisc, your photosare stored in
an iPhoto Libraryfolder, not apackage,
so it’s easier to get into (but otherwise
has the samestructure). Ifyou want to
give the disc to someone who doesn’t use
iPhoto, see “Sharing Photos on Disc with
WindowsUsers,” on page 155.
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Figure 2.28 To get started, select the items you want
to burn, choose Burn from the Share menu, and then
insert a blank disc.

——s. a— — = _ -_

Figure 2.29 Once you've inserted the disc, iPhoto lets
you nameyourdisc and gives you information about
how much data will be burned toit.
 

 

Burn Dise Int SuperDrive &
Burning 92 photos out of a total of 16.971 photos.

Burn Options
Speed: 4x
"} Erase dist before burning
_\ Leave dise appendable

After Burning
MA Verify burned data
@ Gect disc

Cter) Cancel) Gai)

Figure 2.30 iPhoto verifies that you really want to
burn a disc with onelast dialog that also provides
additional burn optionsif you click the triangle but-
ton in the upper-right corner (for more information,
see the sidebar “Burn Options,” next page).

(Mount on Desktop  
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A Proper BackupStrategy

[ll be honest. I think backing up just your
photos by burning them to CD or DVD
is only a small step above useless.Ifyou
value the contents ofyour Mac,andif
you value having a working Mac as a com-
munications device for email and iChat,

you needa real backupstrategy. To learn
more, I recommendJoe Kissell’s Take

Control ofMac OS XBackups ebook
(www. takecontrolbooks .com/backup-

macosx). It’s only $15 and will help you
figure out exactly what hardware and
software you need and howtosetit up.

Burn Options

[recommendthat you select Verify
BurnedData for safety; ifyou have trouble
burning, try reducing the burn speed.

The optionsfor erasing media and leaving
a disc appendable apply only to rewritable
media like CD-RW,but iPhoto won't erase

no matter what; use Disk Utility.

The choice ofejecting the disc after
burning or mountingit on the Desktopis
minor, though I recommendaquick visual
inspection of the contents of the disc in
iPhoto after burning.

True Archiving

Ifyou wantto archive photos,that is, burn
them to disc and then remove them from

your hard disk, | recommendthefollow-
ing:

@ Makeat least two copies and store one
off-site, like at a friend’s house.

@ Work methodically by making albums
from events to retain organization and
by selecting everything in order.
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Other Backup Options
Whatifyou don't have a writable optical
drive or don’t want to end up with your
photos existing only in an iPhoto Library?
You have a few options.

Other backup options:
*

Copy your iPhoto Library (rememberthat
it’s in your Pictures folder) to an external
hard disk.

Use a dedicated backup program,such as
Mac OS X’s own Time Machineor Carbon

Copy Cloner (ww. bombich.com) to back
up your entire Mac,I also like CrashPlan
(www. crashpLan. com) for backing up just
your Homefolderto a friend’s house as an
off-site backup.

Export photosto folders in the Finder,
then manually burn them to CD or DVD
to back them up with your desired orga-
nizational approach.It’s more work, but
you get exactly what you wantat the end.

V Tips

No matter which backup method you
choose, I recommend having more than
one backup copyandstoring one of them
off-site. That way, should your house or
office burn downor be burglarized, your
backup would remainsafe.

To avoid wasting media (though CD-R
discs are awfully cheap), buy the more
expensive CD-RWdiscs and erase them
in Disk Utility between uses.

Don’t use CD-RWdiscsfor true archiving,
since anything that can be erased is a
lousy permanent medium.

Don’t assumethat any backup media
will last forever. Every year or so, check to
make sure your backupsare readable, and
recopy them to new media,just to be safe.

27
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MERGINGiPHOTOLIBRARIES

Chapter2

Merging iPhoto Libraries
Ifyou have two Macs, you may wantto
merge the contents of two iPhotolibraries,
one from each computer.

To mergeiPhotolibraries(I):

1. Network your Macsvia AirPort, Ethernet,
or even FireWire (using IP over FireWire,
which you can enable in the Network
system preference pane).

2. On both Macs, turn on photo shar-
ing in iPhoto’s Preferences window
(Figure 2.31). For more information,
see “Sharing Photos via iPhoto Sharing”
on page 150.

3. On the destination Mac, in the source

pane, drag the desired photos or albums
from the source Mac’s shared album to

Events or Photos.

To mergeiPhotolibraries(II):

@ [fone of your Macs has a writable optical
drive that supports CD-R, CD-RW,or
DVD-R, burn a disc containingall the
photos you wantto transfer from the
source iPhoto Library. Then import them
into the destination iPhoto Library as
explained in “Importing from an iPhoto
Disc,” on page 17.

To merge iPhotolibraries(III):

1, From the source iPhoto Library, export
the desired images by album or event
into folders (see “Exporting Files,” on
page 152).

2. Copy those folders to the Mac with the
destination iPhoto Library via a network
or FireWire Target Disk Mode.

ia Drag the folders into iPhoto to import
their photos (see “Importing from Files,”
on page 15).
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fiShare my photos
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()Share selected albums:
| Photos |
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 Externalized Photos a
Shared name: Adam Engst's Library
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Status: On

  
 

Figure 2.31 To turn on photo sharing, select Look for
Shared Photos and Share My Photosin the Sharing
pane of iPhoto’s Preferences window.

To mergeiPhotolibraries (IV):

@ Use Fat Cat Software's $19.95 iPhoto

Library Manager, which can merge iPhoto
libraries automatically, retainingalltitles,
keywords,ratings, and albums, along with
face and place information. Downloadit
from: www. fatcatsoftware.com/ipLm/.

This option is the mostcostly, but by far
the easiest ifyou're merginga lot ofpho-
tos, or need to merge libraries frequently.

V Tips

m Ifyou're burningto disc, use CD-RW
media if you want to reuse that disc; use
CD-R media if you want a backup.

@ Whenexportingvia the third method,|
recommendusing the phototitle as the
filenameor else you'll lose any work you
putin titling your photos.
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ORGANIZING PHOTOS

Switching to Organize Mode

iPhoto keeps you in organize mode,
except when you're importing photos;
editing photos;creating a slideshow;or
working on a book, card,or calendar.
Thus, there are two basic ways to return
to organize modefrom another mode:

@ Inthe source pane, click any item
in Library, Recent, Subscriptions,
or Albumsto switch to organize
modeanddisplay the contents of
the selected album.

@ Whenyou have switchedinto edit
modefrom organize mode but are not
using the Crop, Red-Eye, or Retouch
tools, double-click the picture to
switch back to organize mode.

Faces and Places, Oh My!

Newin iPhoto ‘09 are Faces andPlaces.

Putbriefly, iPhoto 09 can automatically
organize your photosby recognizing the
people in them. Andit can use location
informationstoredin (or addedto) pho-
tos as a way of placing photos on a map.
Thesefeatures are wildly useful for orga-
nizing photos, so muchso thatI've given
them their own chapters, coming next.
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Oneof the best things, in my opinion, about
digital photographsis that they come with
their own organizational tags built in. We
may not have cameras that can recognize
specific people, but every moderndigital
camera records a great deal of information
about when each picture was taken andits
associated settings. For many people, includ-
ing me, that information alone provides
enoughorganizational power.

However, many people want to do more, and
iPhoto provides a wide variety of tools for
assigning keywords to your photos,collect-
ing them in albums, and more. We'll look at
each of those capabilities in this chapter.

Of course, the only reason to organize photos
at allis so you can find them quickly and
easily later, and iPhoto also shines in that
department, makingit easy to scroll through
your entire photo collection chronologically
or home in on a specific set of photos with
sophisticated yet simple searchingtools.
Wanttofindall the photos taken in June,
July, and August of the last 5 years? Wantto
find all the photos whosetitles or descrip-
tions mention your mother? No problem.
You can even make smart albumsthat con-

stantly search yourentire library for match-
ing photos and present them in an album.

Let’s take a look.

29
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Wuat’sNewINORGANIZEMODE

Chapter 3

What’s Newin

Organize Mode
Ifyou've used the previousversion of iPhoto,
you'll want to pay attention to the newinter-
face elements iPhoto '09 brings to organize
mode (Figure 3.1).

New features in organize mode:
° A new Faces modeusesface detection

and recognition technology to help
you organize photosby the people who
appear in them.Facesis a sufficiently
significant addition to iPhoto that Apple
gave it a prominententry in the source
pane, underthe Library list. For more
information about Faces, see Chapter4,
“Working with Faces,” starting on
page 63.

@ Joining Faces in the Library list of the

30

source paneis Places, which readsloca-
tion information stored in photo files to
show photos on a mapandlet you search
for them bylocation. For more informa-
tion on Places, see Chapter 5, “Working
with Places,” which begins on page 71.

Apple has renamedthe Projectslist in the
source pane to Keepsakes—itstill con-
tainsall your books, cards, and calendars.
Also, Web Gallery is now called MobileMe
Gallery.

iPhoto ‘09 gains newlists for your
Facebook and Flickr albums.
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Figure 3.1 iPhoto ’o9 adds Faces
and Placesto the Library list, cre-
ates newlists for Facebook and

Flickr, and swaps the Projects
name for Keepsakes and the
Web Gallery name for MobileMe
Gallery.

Source Pane?

I follow Apple's leadin calling the items
in the left-handarea in iPhoto “sources”

andtheareaitself the “source pane,” even
though iPhoto no longer explicitly labels
it as some previousversionsdid, In most
cases, things you can do to onetype of
source(like delete it, move it around, or

add photosto it), you can do to all the
types of sources. Whenthat’s thecase,I'll
use the term “sources;” whenthere is an

exception,I'll use the specific term orcall
out the exception.
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Organizing Photos

Organize Tools Overview
Here's a quick referenceto the controls avail-
able in organize mode (Figure 3.2). Note
that this screenshot showsthe Photos view;

the Events view displays a single photo for
each event, makingfor faster navigation.

V Tip

m The Keepsakes pop-up menureplaces the
Book, Calendar, and Card buttons when
the windowis too narrowfor them all to

fit comfortably.

Source pane. Create Drag the dividerto Event, showing its thumbnail, name, date, and numberofphotos.
and work with collec- change thesizeof Drag a photo to the thumbnailto set it as the key photo; double-click
tions ofphotos here. the source pane. the title to changeit. Click an event’s triangle to open andcloseit.
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bell Greene:Oct saea thsbined or click the
desired loca-
tion. Click the

 
end icons for

Click to hide smallest and
and show the largestsizes.
Information
pane, Click to Clickto Search field. Click to hide Click to The buttons in the organize

enter full- assign Enter text here orflagthe playabasic mode’s toolbar help you switch
Screen namesto tofindmatch- selected slideshow. between modesandoffer differ-
mode. faces. ing photos. photos. ent methods ofsharing photos.

31

42

MAIAYSAQS1OO]AZINVDAO



43

CHANGINGTHEDISPLAYPANE’SLAYOUT

Chapter 3

Changing the
Display Pane’s Layout
There are various things you can do to
changethe waythedisplay panelooks.

To change the display panelayout:

¢ Switch among Events, Photos, Faces,
and Places by clicking them in the source
pane.

# Movethesize slider (or click in the

desired location) to adjust the size of
the thumbnails from moderately large
(Figure 3.3) all the way down to as many
photosasfit in the window (Figure 3.4).

@ Double-click a photo to magnify it such
that it occupies the entire window.

@ Toshow orhidetitles, ratings, and key-
words (Figure 3.5), choose the desired
item from the View menu.

@ ‘To add or remove sharing tools from the
toolbar, choose the desired one from the
Show in Toolbar submenuin the View

menu (Figure 3.6).

V Tips

m@ The keyboard shortcuts for zooming
work only on photos, not events.

m You canshrink the source pane by
draggingtheline that dividesit from
the display paneto theleft. Expandit
by dragging backto theright.

m@ Viewingtitles in the display paneisn't
useful when you use smaller thumbnail
sizes, but rememberthat the current

photo'stitle is in the Information pane.

m Eventtitles help show whereyou are
whenin Photos view, so I recommend

leaving them showingandgiving them
names.(Option|-click an event expansion
triangle to hide or showall events.
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Figure 3.3 To view thumbnails at a moderately large
size, move thesize sliderall the way to the right, or
press the 1 key.
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Figure 3.4 To view as many thumbnails as possible,
movethe size slider all the way to the left or press the
o (zero) key. 

 
Figure 3.5 For an uncluttered look in the Photosview,
turn off display of titles, ratings, and keywordsin the
View menu.
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Figure 3.6 Choose
which sharing tools
you wantin the tool-
bar using the Show in
Toolbar submenu.
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Figure 3.7 Use the Sourcessettings in iPhoto’s
General preference paneto control the Last Months
album andthe display of the item count in sources. 

Border. Outline
fi Drop shadow

Black White

OrganizeView: IMAlign photos to grid
M4 Show scrolling information
Use smonth scrntling

Source Text: | Small =]

Figure 3.8 The Appearance paneof iPhoto’s
Preferences windowprovidessettings that control
how iPhoto draws and scrolls through photos, and
the size of source nametext.

 
 

 

 
Double-clickEvent: @Shows Event photos

OMagnifies photo

SA Shaw <crolling Information

Autospiit intoEvents:

Climporteditems from Finder
Herts imporved from foldersof dragged
into (Photo will b¢ autoxplit Into Events. 

Figure 3.9 In the Events preference pane, you can
choose what double-clicking an event does and set
whether you'll see event reflections andthe translu-
cent scrolling feedback display.
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Other Display Preferences
You can set options in iPhoto’s Preferences
window thataffect the display pane.

From the iPhoto application menu, choose
Preferences((CmaJ{, }) to open the Preferences
window;you canfind display preferences in
the General, Appearance, and Events panes
(Figure 3.7 through Figure 3.9).

Display preferences you can change:

@ Inthe General preference pane, use the
Sources controls to chooseif the Last

Monthsalbum appears and how many
monthsit contains.

@ Select Show Item Counts to append the
numberofphotos in each source item to
its namein the source pane.

@ Inthe Appearancepane,select Outline
and/or Drop Shadow borderstyles, and
use the Backgroundslider to change the
darkness of the background.

@ Toalign all your photostoaregular grid
in which the width of the widest picture
sets the widthforall photos, check the
Align Photos to Grid checkbox.

¢@ Use the ShowScrolling Information
checkbox to toggle whetherthe translu-
cent Information dialog appears when
scrolling. In the Appearancepreferences,
this setting affects the Photos view;in
Events preferences, the Eventview.

@ The Use Smooth Scrolling option makes
scrolling via the Page Up and Page Down
keys smoother.

¢@ Fora morespartanlook, turn off event
reflections in the Events preference pane.

@ Set what happens when you double-click
an imagein the General preference pane
and what happens whenyou double-click
an eventin the Events pane.
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CONTEXTUALMENUSHORTCUTS

Chapter3

Contextual

MenuShortcuts

Although iPhoto does a good job of mak-
ing most of what you can dovisible in the
interface, you can also (Control}-click (or, ifyou
have a two-button mouseor appropriately
configured trackpad,right-click) a photo to
bring up a contextual menu thatlets you
perform a numberofactionsdirectly on
the photo you clicked (Figure 3.10).

Contextual menu shortcuts:

@ You can cut, copy, or paste photos,for use
both inside iPhoto andin other applica-
tions, Cutting a photo removesit from
the current albumandpasting a photo
addsit to the current album (neitheris

true of smart albums).

@ The Edit commandsare particularly use-
ful for opening photosin alternative ways
without switching iPhoto’s preferences.

@ Show File and ShowOriginal File switch
you to the Finder. ShowFile selects the
originalfile if no changes have been
made; if changes have been made,it
selects the edited version. Andifchanges
have been made, Show OriginalFile
selects the original. Yeah,it’s confusing.

@ Therest of the commands—Rotate, Get

Info, Batch Change, Duplicate, My Rating,
Make Key Photo, Hide Photo, Move to
Trash, and Revert to Original—arelike
those in iPhoto’s Photos and Events

menus, but using the contextual menu
to apply them mayfeel moreintuitive.

VY Tip

m™ You can often drag photos from iPhoto to
other applications instead of using copy
and paste.

34

45

 
Cut

Copy
Paste

Edit

Edit Using Full Screen
Edit in External Editor

Rotate Clockwise
Rotate Counter Clockwise

Get Info
Show File

Show Original File

Batch Change...
Duplicate

My Rating >

Make Key Photo
Hide Photo
Move to Trash

Revert to Original

Figure 3.10 Control-
click one or more

selected photos to
display iPhoto’s
contextual menu

 
L shortcuts.

V More Tips

m Some of the menuitems become unavail-

able when they don’t make sense(for
example, you can’t paste into the Events
and Photos views, and Revert to Original
doesn’t apply to original photos).

m™ Move to Trash changes to Delete From
Album when you're notin the Events or
Photos views.
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Figure 3.11 You can change Mac OS X’s scrolling
behavior in the Appearance preference pane.
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Moving around in iPhoto
Obviously, you can move around in iPhoto
by scrolling, but knowinga few tricks and
techniques can make navigating through
your photoseasier.

Ways to move around:

@ Click or drag in the scroll bar, just as you
would in any other Macapplication.

@ (Option)-click the scroll bar to jump to the
particular spot youclicked.

@ Click a photo to makesurethe display
paneis active; then use the arrow keys
to move around.

@ With the display pane active, use
and to scroll through your
photos onescreen at a time.

¢# With thedisplay paneactive, use
and to moveto the top and bottom

of the currently displayed photos.

V Tips

@ The (Option|-clicking (Jumpto Here)
behavior applies to Mac OSX in general,
and you can makeit the default clicking
behavior by selecting the Jump to Here
radio button in Mac OS X’s Appearance
preference pane (Figure 3.11).I find the
Jump to Here setting disconcerting, since
it’s counter to the way I've usedscroll
bars on the Macforever.

@ Ifyou're having trouble scrolling toa
desired location,it might help to reduce
the thumbnail size so you can see many
more thumbnails on the screen at once.

@ Hold down whenscrolling to scroll
smoothly. This feature may not help
many people, but it made arranging the
iPhoto window(to take nicely aligned
screen shots) a lot easier for me while I

was writing this book.
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WORKINGWITHEVENTS

Chapter3

Working with Events
Events are key to iPhoto, and Apple has
provided lots ofways to work with them.

To rename an event:

# Wherever yousee an eventtitle, click
it to edit, and then type the new name
(Figure 3.12).

To view photosin an event:

@ In Events view, move the mouse pointer
horizontally over the key photo to view
all the photosin the event. This is called
scrubbing, and it’s wildly cool.

@ In Events view, double-click an event, or

select several events and double-click one

of them (Figure 3.13). To return to view-
ing event thumbnails,click the All Events
button or double-click on any blank spot.

@ When viewing the photosin an event,
click the arrowsat the top right of the
window (shownin Figure 3.15) to move
to the previous and next events.

¢@ In Eventsview, select an event and

choose Open in Separate Window from
the Events menu,or(Control]-click it and
choose the same command from the

contextual menu, to open a new window
showing just the photos in that event
(Figure 3.14).

To change an event’s key photo:

@ Jn Events view, scrub over the pho-
tos until the desired oneis showing,
(Controi)-click it, and choose Make Key
Photo. Or press(Spacebar).

@ When viewing the photosin an event,
select one and choose Make Key Photo
from the Events menu,(Control-click it and
choose Make Key Photo,or dragit
to the key photo well (Figure 3.15).
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 Figure 3.12 Anywhere
you see an event title,
just double-click it to
editit.
 

  
 

Figure 3.13 Select two or more events and double-
click one of them to viewall their photos together.
 

 
Figure 3.14 Opening an event in its own window can
be a good way to focus on just the photosin that
event, or to compareit with the contents of another
window.
 

  
- an|Dene eee

HAHA Re
Figure 3.15 Drag a photo to the key photo well to
makeit the key photo.
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Splitting and
Merging Events
It’s all too easy to end up with photosthat
aren't in the right events. You can split events
apart, merge events together, and move pho-
tos from one eventinto another.

Waysto split an event: 
 

# Whenyou're importing new photos,
check Autosplit Events after Importing.

 
Figure 3.16 To split the selected photos into anew
event, select some photosandclick the Split button @ In Events view, select one or more events

at the left of the toolbar. and choose Autosplit Selected Events
from the Events menu.

@ When viewing an event's photos, select
one or more photosandclick the Split
button (Figure 3.16) or choose either
Split Event or Create Event from the

‘s Events menu.
eestes) 

Ways to merge events:

Figure 3.17 Drag one event onto another to merge the * In Events view, drag one eventinto
PARENERIS: another event (Figure 3.17) or select two
—— events andclick the Merge button,
 

@ Select two or more events in Events view,

double-click them to view their photos
ie together,select one event, and either

dragit to another event, click the Merge

 
 oneeee button, or choose Merge Events from the

Events menu.

-- Ui b }E ~ > Ways to move photos betweenevents:
» # £ . s ¢# In Photosview, drag photos from one
 

event into another event (Figure 3.18).
Figure 3.18 To move photos betweenevents, drag ; ; ;
photos from one event to anotherin Photosview. ¢ Select multiple events in Events view,

double-click them to view their photos,
and drag photos from oneto the other.

Autosplit Preferences
@ Inone event, select one or more photos,

: ‘ cut them by choosing Cut from the Edit
set iPhoto’s autosplit feature to create menu((Gmd)(X)), switch to anotherevent,
one new eventper week, one per day, one and paste them by choosing Paste from
every 8 hours,or one every 2 hours. the Edit menu ((GmaJv)).

In the Events preference pane, you can
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CREATINGANDWORKINGWITHFOLDERS

Chapter 3

Creating and
Working with Folders
iPhoto provides folders into which you can
organize albums, and, although it may not
seem obvious, books, cards, calendars, saved

slideshows,and otherfolders. Folders are a

great way to tuck awayolderitems.

To create a folder:

1. From the File menu, choose New Folder

((GmalShif{Option|N)) or (Contrai)-click in an
empty spotat the bottom of the source
pane and choose NewFolder.
iPhoto creates a new untitled folder with

the nameselected so you can nameit.

2. Enter a nameforthe folder.

To move items into and out of folders:

¢@ Drag one or moreitems(albums, books,
slideshows,etc.) into or out of the folder,

iPhoto movestheitems,giving the folder
an expansiontriangle if necessary sa you
can open andclose it (Figure 3.19).

To duplicate a folder andits contents:

 (Control)-click a folder and choose
Duplicate from the contextual menu that
appears.

To delete a folder:

@ Select one or more folders and press
{Delete}, or (Control-click a folder and choose
Delete Folder from the contextual menu

that appears.

iPhoto prompts you to make sure you
know what you're doing;click Delete
to delete thefolder andall its contents.

@ Select one or more folders and press
to delete them andtheir con-

tents (albums, slideshows, books, etc. but
not the associated photos) without being
prompted for confirmation.
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Figure 3.19 Drag itemsinto
or out of a folder to add or
remove them from thefolder.

 
Facts about Folders

Folders can takea bit of getting used to:

@ Folders appear only in the Albums
list in the source pane, but you can
moveitems from the Keepsakes and
Slideshowslists into folders. When

you removesuch items fromafolder,
they snap back into the appropriate
lists.

@ Folders cannot contain MobileMe,

Facebook, orFlickr galleries.

# Whenyouselect a folder in the source
pane,the display pane shows all the
photos from all the albums,slide-
shows, books, cards, and calendars

inside thatfolder.

# Whenyoudelete a folder, you delete
the items (albums, books, and so on,

though notthe original photos, of
course)insideit as well. Be careful!
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PragDragthedividerto|ake the source

pane wider to
how long album

names.

Addbutton. Click
to add an album.

 
 

Figure 3.20 To create a new
album,first click the + button
at the bottom of the source

pane.

 
 
|

iv =

Figure 3.21 Next, select Album a the icicon list,
name the album, andclick Create.

 

 
Figure 3.22 When you drag photosinto the source
pane to create a new album containing them,notice
how the entire source panegets a thick blue border.
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Creating Albums
iPhoto provides albums to help us categorize
photos—these were from theFiji trip, those
were from Joe’s birthday party, and so on.
Albumsarealso useful starting points for
saved slideshows, books, and calendars.

To create an album:

1. Click the Add button (+) at the bottom of

the source pane (Figure 3.20), or choose
New Album ((CmdJN}) from the File menu.

iPhoto displays a dialog asking what type
of item you wantto create,ifyou want to
add any selected photos toit, and what
you wanttocall it (Figure 3.21).

Be Choose Album from the item iconlist,

enter a name, and click Create to addit to

the source pane.

Other waysto create an album:

@ Select some photos, and then follow the
steps aboveor just choose New Album
from Selection ((€md)Shift(N}) from the File
menu.

@ Drag one or more photos, or an entire
event, into the source pane, onto the
Albumslisttitle (Figure 3.22).

@ Drag one or more photos,or a folder of
photos, from the Finderinto the source
pane, onto the Albumslisttitle.

(Control-click an empty spot at the bot-
tom of the source pane and choose New
Album or New Album From Selection.

V Tip

m@ Use albumsfor categories of pictures that
appear oncein your photocollection.
Use keywordsfor categories that recur
throughout your collection. Albums work
well for a specific trip's photos; keywords
workbetter for identifying all pictures of
your family membersor recurring events.
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CREATINGANDEDITINGSMARTALBUMS

Chapter3

Creating and
Editing Smart Albums
Unlike normal albums, which you must
maintain manually, smart albumsuse a set
of rules that you create to maintain their
contents automatically.

To create a smart album:

1. Click the Add button (+) below the

source pane, select Smart Album from
the item iconlist, and click Create. Better

yet, either (Option)-click the Add button,
choose New Smart Album ((Cmd{Option|N))
from the File menu,or (Control}-click an

empty spot at the bottom of the source
pane and choose New Album.

iPhoto displays a dialog for you to name
and configure your album (Figure 3.23).

2. Enter anamefor the new album.

3. From thefirst pop-up menu,choose a
criterion that photos must match to be
included (Figure 3.24).

4. From the second pop-up menu, choose
how thatcriterion should be evaluated

(Figure 3.25).

5. Enter a condition against which the
criterion is to be evaluated (Figure 3.26).

6. If you want your smart album to have
multiple criteria, click the + button and
repeat steps 3-5.

7. When you're done, click the OK button.

iPhoto looks at all your photos and adds
those that match to the smart album.

To edit a smart album:

1. (Control)-click an album and choose Edit
Smart Album from the contextual menu.

2. Follow steps 2-7 above to change the
smart album's nameor configuration.
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Soa, Atm mine:(ayFess(4-5Sts)
Match the followingtondivion

ag) perme— vee Cro
Comat) =) 

Figure 3.23 Name and configure your smart album
in the dialog that appears after choosing New Smart
Album from the File menu.

Album
Any Text
Description
Date
Event
Filename
Keyword

Name
Place
Photo
Title

Aperture
oeee Figure 3.24 Smart albums can
Flash match photos based on numerous
Focal Length criteria, shown here. In this case,
iso I’m looking for photos witha
Shutter Speed|snecific rating.

 
¥ is greater than

is less than

is in the range

 
 
Figure 3.25 Once you've
chosen a criterion, you
must determine howit

should be evaluated. The

second pop-up menu
changes dynamically
to match the selected

criterion. Here, since

I’m matching on rating,
and because I'd like the

smart album tofind only
photos with 4 or5stars,
I’ve chosen Is Greater

Than.
 

tytatng1B)ngreaerian vee
Figure 3.26 Lastly, enter the condition against which
yourcriterion will be evaluated. To finish the smart
album that matches my 4- or 5-star photos,I’ve
clicked the field to select 3 stars. Read as a whole, my
rule says, “Select all photos whoserating is greater
than 3 stars.”
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Folders Enhance Smart Albums

There's a problem with smart albums.
When a smart album has multiple crite-

ria, you must choose whether the smart
album should match AnyorAll of the
conditions you specify. So I could have
a smart album thatfindsall the photos
containingeither Tristan or Tonya (Any)
or both Tristan and Tonya(All). But,if I
wanted the smart album to show meall

the photosofeither Tonyaor Tristan that
are rated 5 stars, there's no way do define
that in the smart album interface.

Reader Charles Jacobs came up with the
solution: folders. Since folders by defini-
tion combineall the photos from their
enclosed items, I could makea folder con-

taining a smart album thatcollects all the
photos ofTonyathat I'd rated as 5 stars
and another smart album ofTristan’s

5-star photos. Selecting thefolder in the
source pane would display all the desired
photos. And oncethey're collected in that
folder, I could easily work with them as
a group, perhaps makinga slideshow or
setting them as myscreensaver.

So ifyou're having troublefiguring out
how to bend smart albumsto yourwill,
consider the humblefolder.

Organizing Photos

Smart Album Ideas

Here are someideasto help you get started
with making useful smart albums.

Smart album ideas:

¢@ By matching onratings, you caneasily
create a Favorites smart album that con-

tains just your top-rated photos.

@ Use the new Face criterion to make a

smart album that collects all “unnamed”

photos to makeit easier to train iPhoto’s
face-recognition feature.

@ The Photocriterion lets you select spe-
cific kinds ofphotos, including those that
are flagged, hidden,or edited, and those
that are really movies or in RAW format.

@ The new Place criterion is useful for find-

ing all the photos fromastate or country,
even thoughtheindividual photos have
more specific locations.

# With the Camera Modelcriterion,it’s

easy to create a smart album that con-
tains photos taken by camerasother than
yours—likely photos that were taken by
other people and sent to you.

@ Tocreate an album that containsall the

photosofa person, use the Any Text
criterion matching that person’s name.It
will also pick up any photosidentified by
the Faces feature (which you can access
directly via the new Namecriterion).

V Tips

m Youcan't remove photos from a smart
album manually; the only way to take
them outis to changeeither the photo
or the criteria so they no longer match.

m@ Thefact that you can nowfind photos
that have been edited could be very useful
ifyou were ever exporting all your photos
from iPhoto to another program.
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DUPLICATINGSOURCES

Chapter 3

Duplicating Sources
Anything you can create in the source
pane—except a MobileMe, Facebook,or
Flickr Web album—you can duplicate.
Duplicating isn’t something you'll use
every day, but it can beuseful.

Waysto duplicate a source:

® (Control-click an item in the source pane
and choose Duplicate from the contex-
tual menuthat appears (Figure 3.27).

@ Select an item in the source pane, and
then choose Duplicate from the Photos
menu({CmdJ0)).

iPhoto duplicates the album, appending
“2” to its name (Figure 3.28).

Reasonsto duplicate sources:

@ Ifyou're makingpicture books for two
sets of grandparents,for instance, you
might wantto usea very similarset of
photos with different text. Lay out one
book, then duplicate it to eliminate the
effort of arranging photos again.

@ Ifyou want makedifferently themed
booksor calendars with the sameset

of images, create one, then duplicate it
and change the themeofthe duplicate.

¢@ Ifyou've put quite a lot of work into a
book, calendar, or slideshow, and you
wantto try something without poten-
tially messing up your work, make a
duplicatefirst.

¢ Ifyou've constructed a complex smart
album and want to make anotherthat’s

only slightly different, duplicating the
first one and modifying the duplicate is
easier than making a new one.

V Tip

m Rememberthat duplicating a folder also
duplicates everythinginsideit.

42

53

a OE Smart Album
Sort Albums
Duplicate

1 Delete Slideshow 
 

Figure 3.27 To duplicate
a source, Control-click

it and choose Duplicate
from the contextual
menu.

Figure 3.28 iPhoto
appends a numberto the
name of the duplicate.
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Figure 3.29 To rename a
source (such as one you
just duplicated), double-
click its name andeditit.

Figure 3.30 To move an
item in the Sourcelist,
drag it to the desired
location.
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Renaming and
Rearranging Sources
You'll undoubtedly want to renameevery-
thing in the source paneto give the items
descriptive names. Plus, since iPhotoinitially
lists sourcesin the order you created them,
you'll probably want to move them aroundin
thelist.

To rename a source:

@ Double-click the source’s name, and then

edit the name (Figure 3.29).

To rearrange the sourcelist:

@ Draga source to the desired location in
the list. Note the blue bar that indicates

where the item will appear when you drop
it (Figure 3.30).

@ (Control-click any item in the source pane
and choose Sort Albumsfrom the contex-

tual menu that appears.

iPhoto alphabetizesall the items in the
source pane, other than folders and their

contents.It’s a little wacky.

V Tips

m@ Names need not be unique(butit’s a
goodidea to avoid replicating them).

m@ Each type ofsource—folders, albums,
smart albums, books,cards, calendars,

andsavedslideshows—sorts together
(both in the source paneandinsidefold-
ers), and you can rearrange items only
within each type.

™ Youcanuse iPhoto’s spelling tools while
editing names.Fordetails, see “Checking
Spelling as You Type,” on page 183.

@ Youcan(CGmd)-click or(Shift}-click to select
and move multiple sources at once.
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Chapter 3

Deleting Sources
It's easy to create itemsin the source pane,
but ifyou decide you don’t want oneclutter-
ing yourlist, they're even easierto delete.

Waysto delete a source:

¢@ Select one or more items and press
(Delete),

iPhoto prompts you to make sure you
know whatyou're doing;click Delete
to delete the source (Figure 3.31).

@ Select one or more items and press
(Cmd][Delete).

iPhoto deletes the items instantly, with-
out asking for confirmation.

@ (Control-click an item and choose Delete
from the contextual menuthat appears
(Figure 3.32).

iPhoto prompts you to make sure you
know what you're doing; click Delete
to delete the item (Figure 3.31).

vV Tips

@ Youcan't Undothe actofdeleting some-
thing from the source pane.

m@ Deleting an album (or anythingelse in
the source pane) doesn’t affect the origi-
nal photosin yourlibrary since albums
merely contain pointers to the originals.

@ Deleting a folderalso deletes all the
albums,slideshows, books,etc. (but not
their photos)insideit. Be careful!

@ Don'tfeel that albums must be created

carefully and then kept forever. It’s totally
reasonable to group a bunch of photosin
an album, work on them fora little while,

and then delete the album.

@ Onthe other hand,ifyou think you might
wantto use an item again, store it away
inside a folder for future reference.
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\ Are you sure you want to delete the
i _ keepsake "A Lousy Card”?

Figure 3.31 iPhoto prompts to make sure you wantto
delete the selected item. Click Delete if you do.

 

Figure 3.32 You can
Control-click an item

in the source pane and
choose Delete to delete

it, though that’s harder
| than just pressing
|} Delete or Command-

Delete.

Edit Smart Album
Sort Albums
Duplicate

Deleting Web Albums

Whenyou delete a MobileMe, Facebook,
or Flickr album from within iPhoto, the

photos disappear from the Webaswell.
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Figure 3.33 To select multiple pictures by dragging,
click in an emptyarea of the display pane, and then
drag a selection rectangle over the desired photos.

Select Multiple Albums

Don't assume you must work with only
the photosina single album at a time.
You can select multiple albumsat once by
(Cmd)- or (Shift|-clicking album names, and
whenyoudo that, the photosfrom all the
selected albums showin the display pane.

Similarly, ifyou select a folder, the display
pane showsall the photosinall the items
inside thatfolder.
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Selecting Photos
Throughoutthe rest of this chapter,I tell
you to select photos before performing some
task. I’m sure you have figured out the basic
waysofselecting and deselecting images, but
someothers aren't so obvious.

Waysto select photos:

@ Click a phototoselectit.

@ Click one phototo select it, hold down
[Shift], and then click another photo to
selectit and all the interveningpictures.

@ Click one phototo select it, hold down
(Cmd), and then click additional photos
to add them to the selection individually.

* Click in an emptyareaof the display
pane, then drag a selection rectangle
over the photos you wanttoselect
(Figure 3.33). Ifyou drag to the top
or bottom ofthe display pane, iPhoto
scrolls the pane andkeepsselecting
additional images.

@ When viewing photos, chooseSelect All
((Cmd][A}) from the Edit menu to selectall
the imagesin the current album.

@ In Photos view, use the View menu to

makesure eventtitles are showing, and
then click an eventtitle to select all the

images in that event.

Waysto deselect photos:

@ To deselect one ofseveral selected

images, (Cmd)-clickit.

* Todeselect all photos, click in the
empty area surrounding the photos or
choose Select None from the Edit menu

((Cmal(Shitt(A)).

V Tip

m@ iPhoto slows to a crawlifyou click Photos
and then doaSelectAll.
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Chapter 3

Adding Photos to Sources
Even after you've made an album,book,
calendar, Web album,or saved slideshow, you
can add photosto it (rememberthat smart
albums populate themselves).

Waysto add photosto sources:

@ Select one or more photosin the display
pane and drag them ontoa source other
thana folder, which can hold only other
sources. Note the thick, blue border that

appears when you drag over a source
(Figure 3.34).

@ From the Finder, drag one or more
photos, or an entire folder of photos, to
a source. iPhoto imports the photos and
then adds them to the source. Note that

the photoswill appearin thelibrary also,
notjust in the source.

¢@ Drag photos from the display pane
into the source pane, but not onto a
specific source (the easiest drop location
is the Albumslist title). This technique
creates a new album and adds the images
to it (Figure 3.35).

@ Select photos, choose Copy ((CmdJC})
from the Edit menu,click the desired

destination album, and choose Paste

((Cma{V)) from the Edit menu.

@ (Control]-click one or moreselected photos,
choose Copy from the contextual menu
that appears, switch to the desired album,
(Control)-click a blank spotin the display
pane, and choosePaste from the con-
textual menu.It’s the sameidea as the

previous method.

Vv Tip

m@ Youcan adda photo toasource only
once. To put a photoin a source twice,
you must duplicate it—see “Duplicating
Photos,” on page 85.
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Figure 3.34 To add photosto a source, select them
and drag them onto the desired source in the source
pane. Note how the destination source gets a thick
blue border and how the pointer changes froma plain
arrow to one with a+ badge. iPhotoalsotells you,
via a numberina red circle, how many images you're
dragging. 

 
Figure 3.35 To create an album and add photostoit
in one fell swoop, select the images and drag them to
Albumslist title in the source pane.
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Figure 3.36 To removethe picture from that album,
Control-click a photo and choose Delete From Album.
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Removing
Photos from Sources

As you work with a source, you may decide
that you don’t want someof the images in
the source, Luckily, they're easy to remove.

Ways to removephotos from sources:

@ Making sure you're in the desired source,
select the photos you want to remove and
press[Delete].

@ Select the photos you want to remove,
and choose Delete From Album from the

Photos menu ((Cmd)[Delete}) or, for albums
only, Cut ((Gmalx)) from the Edit menu.

@ Drag the photos you want to remove to
the Trash album.

¢@ For albumsonly,(Control-click one or more
selected photos, and then choose Cut or
Delete From Album from the contextual

menu (Figure 3.36).

@ Toremove a photo from a smart album
you musteither redefine the smart album
or change the photo's information such
that the photo no longer matches the
smart album’scriteria.

V Tips

@ Removing a photo from an album, book,
card, calendar, or saved slideshow doesn't

delete it from yourlibrary.

@ Removingaphoto from a Web album also
removesit from the MobileMe, Facebook,

or Flickr Website.

m@ Ifyou make a mistake, either choose
Undo from the Edit menu ((CmaJZ)) or
add them again.

m Draggingaphoto to the Trash album
from another album doesnotdeleteit

from yourlibrary, nor does it copy the
photo to the Trash album.

47

sa0unOSWOUSOLOH,DNIAOWAY



59

SORTINGPHOTOS

Chapter3

Sorting Photos
iPhoto can perform four sorts, or you can
move images around manually, whichis use-
ful for arranging photosin albums you can
use for books, calendars, and slideshows.

To sort photos automatically:

1. Whenin any album, choose the desired
sort method from the View menu’s Sort

Photos submenu (Figure 3.37).

2. From the Sort Photos submenu, choose

either Ascending or Descending to con-
trol the direction ofthe sort (ascending
sorts go from oldest to newest, A to Z, 1
to 9, whereas descendingsorts go from
newestto oldest, Z to A, 9 to 1).

To sort photos manually:

¢@ Drag one or more photosto the desired
location in the album, as marked by a
blackline (Figure 3.38).

@ To make iPhoto forget your manual
changes, switch to an automatic sort
and then choose Reset Manual Sort.

V Tips

@ Albums maintain individual sort settings.

m@ iPhoto remembers how you've sorted
photos manually even ifyou switch to
anothersort order and back to Manually.

m™ You can't sort photos manually in smart
albums, in the Events and Photosviews,

or in the automatically generated albums
like Last Import and Last 12 Months.

™ Whenyou're viewing Events, the Sort
Photos submenuchangesto Sort Events
andlets you sort events the same ways
you sort individual photos.

m@ It’s mucheasier to sort photos manually
in an album thanin a book,calendar, or

slideshow, so create an albumfirst.
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Event Titles
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Show in Toolbar eya
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Thumbnails
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Reset Manual Sort

Figure 3.37 To sort photos, choose the desired
method from the Sort Photos submenu.

 
Figure 3.38 To sort photos manually, drag one or
more photosto the desired location, as indicated
by a black line between photos.
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The Liberty Bell

Figure 3.39 To assign atitle toa
photo, double-click its title and enter
a new one.

 
 

Set [Title

Pond Shadows

| fA Append a numberto each photo

| ews
Figure 3.40 Batch Change enables you to set the
titles of multiple selected photosall at once, append-
ing numbersif you so desire.

 

set (Tile189to (DateTime1B

Select the Dateand Time format to be used forsettingthe
titlesoftheselected photos.

| include Date:

 

M include Time
© Short -@ 12-hourclock
O Abbreviated (O24-hourclock
Olong 1ShowSeconds

3/7/0905:06 PM 
Cancel) Gee

Figure 3.41 When changingthetitle of a photo to
Date/Time, set the formatin the dialog beforeclick-
ing the OK button.
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Assigning Titles to Photos
Digital cameras assign sequential numeric
namesto photos, but iPhoto lets you add
your owndescriptivetitles. Smart albums
can look for text in titles, and iPhoto can use

the titles when you design booksor publish
to the Web.

Waysto assign customtitles:

@ Makesuretitles are showing (choose
Titles from the View menu;(Cmd|Shitt(7)),
and then anywhere youseea title, click it
andenterthe newtitle (Figure 3.39).

¢@ Ineither the Information paneor the
Information dialog ((CmaJ1)), click the
Title field and entera title for the photo.

To assigntitles to multiple photos:

1. Select a numberof photos, and choose
Batch Change((CmdJShift{B)) from either
the Photos menuorby(Control)-clicking
the photos,

2. Inthe dialog that appears, choose
Title from the Set pop-up menu, and
then choose Empty, Text, Event Name,
Filename, or Date/Timefrom the To pop-
up menu(Figure 3.40).

3. Ifyou chose Text or Date/Time,select
the desired optionsin the dialog
(Figures 3.40 and 3.41).

V Tips

m™ Keeptitles short so they're easy to read in
the display and Information panes and so
they fit when used in Webpages.

@ Youcanassigna title to multiple selected
photosin the Informationdialog too,

m Ifyou dontlike the way the batch change
worksout, just choose Undo Batch
Change from the Edit menu.
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ASSIGNINGDESCRIPTIONSTOPHOTOS

Chapter3

Assigning
Descriptions to Photos
It’s often helpful to describe a photobriefly
so you remembertheoriginal scenebetter.
iPhoto also uses descriptions as text in some
of the bookdesigns.

To assign a description to a photo:

@ Select a photo, choose Get Info from
the File menu ((Cma)(1)) to display the
Information dialog and type your
description in the Descriptionfield.

@ With the Information pane showing,
select a photo and type your description
in the Description field (Figure 3.42).

To assign descriptions
to multiple photos at once:

1. Select a numberofphotos, and choose
Batch Change((CmdJShift(8)) either from
the Photos menuorby(Control)-clicking
the photos.

2. Inthe dialog that appears, choose
Description from the Set pop-up menu,
and then enter the description to attach
to each photo (Figure 3.43).

3. Ifyou want to append yourtext to
each description,instead of replacing
what's there, select Append to Existing
Description and click OK.

iPhoto changesthe descriptions.

V Tips

m@ Ifmultiple photosare selected, the
Information dialog appends what you
type in the Descriptionfield to the
description of each photo.

@ You can use iPhoto’s spelling tools in the
Description field. See “CheckingSpelling
as You Type,’on page 183.
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Drag to make the
Information pane
taller and wider

to show large
descriptions.

Information
button.

Description
field.

title Wtica Train Station
date 3/20/2004
Mime 6:43:07 AM

ning tore «
keyword

kind JPEG Image
size 227? x 1704

Read more about the Utica Train / 
Figure 3.42 To assign a description to a photo, select
the photo and enterthe description in the Description
field in the Information pane.

 

Set | Description i to 
m the train station,

‘MlAppendta existing Description

Figure 3.43 Use the Batch Change commandto
change or append to the description for a number
of photosat once.

  
 

V More Tips

m@ The Description field can hold a very
large amountoftext. Ifyou need long
descriptions, create them in another
application and paste them into iPhoto.

m@ You can dragor use the arrow keys to
scroll through too-long descriptions.
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| Set [Rate Ta to

Date; 3/ 7/2009 5:19:05 PM [3]

Mada: [Minute ji) betweeneach photo
1 Modifyoriginalfiles

 

Figure 3.44 Use the Batch Change command
to modify the dates of multiple photos at once.

  
 
  

 
  

The dave and tree of your fir photoiywager Adjust ib bp the cotrent tie, devel all 4voto well be timeswhifted actordinaty
Origa): (1/1/2000 Tetg)s4 oe

F nauites:[1)1/2000mRimwfs

rel) ae 

Figure 3.45 Use the Adjust Date and Time command
to increase or decrease the dates of multiple photos
in relation to the first one in the selected set.

V More Tips

@ Modify Original Files always changes
the file dates in the Finderto the current

date, not the date youset.

@ I|fiPhotois set to arrange photos by date,
changing a photo's date causesit to be
re-sorted according to the new date and
it may moveto an unexpectedplace.

m@ Inthe Batch Changedialog, you can type
numbersinto the date and timefields,

use the arrow keys to movethe values up
and down,or click the up/down arrow
controls to adjust the selected number.

m When using Batch Changeto modify a
numberofphotos with a time increment,
note that iPhoto changes them in the
order(left to right, top to bottom) that
they're currently arranged.

m@ It’s a goodidea to use the time increment
with Batch Change so you can be sure
how photoswill sort by datelater on.

Organizing Photos

Editing Photo Dates
You can edit photo dates in iPhoto to cor-
rect problems caused by your cameralosing
track of the correct date and time. Note that

Batch Changesets each photo's date, whereas
Adjust Date and Time adjusis each photo's
date in relation to how youset thefirst one.

To edit a photo’s date and time:

@ Make sure the Information paneis show-
ing, and thenselect a photo andeditits
Date and/or Timefields.

To edit multiple dates/times at once:

1. Select a numberof photos, and choose
Batch Change((Cma)Shift(B)) from either
the Photos menuorby (Control)-clicking
the photos,

ad In the dialog that appears, choose Date
from the Set pop-up menu,and then use
the controls to set the date and time to

attach to each photo, and the amount of
increment time (Figure 3.44).

iPhoto changesthe dates appropriately.

To adjust photo dates and times:

1. Select an event or a numberofphotos,
and choose Adjust Date and Time from
the Photos menu.

2. Inthe dialog that appears, use the con-
trols to set the new date and/or time for

the first photo (Figure 3.45).
iPhoto calculates the offset between the

ald and newdatesfor the first photo and
adjusts the datesforall the other photos
accordingly.

v Tip

m Use the Modify Original Files checkbox
to ensure that your changesare saved in
the EXIF data for each photofile as well,
rather than just being stored in iPhoto.
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Chapter3

Assigning Ratings
Just as with iTunes, where you can rate your
favorite songs on a scale of 1 to 5 stars, you
can rate your photos, whichis a great way to
identify yourfavoriteseasily.

Waysto assign ratings:

@ With ratings showing (choose Rating
from the View menu;(CmdJ(Shift{R)), click
the appropriate star buttonin the rating
field under a photo (Figure 3.46).

@ Select one or more photos, and from
the My Rating submenuin the Photos
menu, choosethe desired rating. Note
the through keyboard
shortcuts—ifyou're evergoing to use
keyboardshortcuts, nowis the time.

@ Select one or more photos, (Control)-click
oneof the selected photos, and choose
the desired rating from the My Rating
submenu(Figure 3.47).

@ Select one or more photos, choose Get
Info from the File menu ((CmaJ1}), and
click the appropriate star button.

@ With a photoselected,click the appropri-
ate star button in the Information pane,

After you choosea rating, iPhoto applies
it to the selected photos, displayingit
below each photoifyou have Rating
turned on in the View menu.

V Tips

m The keyboard shortcuts for rating photos
are available when you'reediting a photo,
but as of iPhoto ’09, you can no longer
assign ratings while watching a slideshow.

@ You can changethe rating for a photo at
any time;it’s by no meansset in stone.

@ iPhoto considers 5 stars better than 1

star, although there’s nothing stopping
you from assumingthereverse.
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Agate Beach in California

weary,

Figure 3.46 To assign a rating to a photo,
make sure ratings are showing and click
the desired star button.
 

 
Figure 3.47 Alternatively, Control-click the photo and
pick the desired rating from the My Rating submenu.

Consider Using
Only High Ratings

Don’t assume you mustrate all your
photos. Myfeeling is that there's relatively
little point in rating anything with 1 or 2
stars, since those ratings basically mean,
“Tlike this photo only enoughto keepit.”
I consider 3 stars an averagerating, so I
usually don’t use that either, reserving my
rating effort for the 4- and 5-star photos
that are my favorites.

Remember, too, that you can create smart
albums that match photos whoseratings
are lower than a set number, so you could
easily find all the photos that didn’t have
4or 5 stars.



64

 

 

“Keyword iShorteut |_|

| Chris
Cornell University
Flaine
Event

Family f
Favorite

Friends i ha
Holiday

  
Figure 3.48 In the Edit Keywords window,you can
add, remove, and rename keywords, and assign
single-key shortcuts to them.

 

Unexpected Keywords

Ifyou find keywordsin thelist that you
can’t remembercreating, you're notlosing
your mind.If a photo sent to you by a
friend contains a keyword, iPhoto imports
it. There’s no reason tosaveit.

Working with the
Checkmark Keyword

iPhoto provides a special checkmark
“keyword”that, when applied to a photo,
appearson top ofthe imageitself, rather
than underit, like all other keywords.
Plus, the checkmark appears whether
or not other keywordsarevisible. It can
7be useful as a temporary marker.

However, iPhoto's flagging capability
makes the checkmark keywordless useful
than it used to be, since it’s easier to work

with flagged photos thanksto the special
Flagged album and other commands
related to flagged photos.

Organizing Photos

Managing Keywords
iPhoto ’09 offers an easy interface for work-
ing with keywords. Before going further,
when you're viewing photos (as opposed to
events), make sure keywords are showing
by choosing Keywords from the View menu
((Cmd)Shift|(K)). Also, open the Keywords win-
dowby choosing Show Keywords((CmdJk])
from the Window menu.Thenclick the Edit

Keywords button.

Waysto create a new keyword:

@ Inthe Edit Keywords window,click the +
button, type the new keyword, and press
(Return).

@ Click in the Keywords field under any
photo, type the new keyword,and press

or()}.

To assign a keyword shortcut:

@ Inthe Edit Keywords window,either
double-click a keyword shortcutor click
Shortcut, type the single letter shortcut,
andpress(Return).

To rename a keyword:

@ Inthe Edit Keywords window,either
double-click a keyword orselect it; then,
click Rename, type the new name,and
press (Figure 3.48).

To delete a keyword:

@ Inthe Edit Keywords window,select a
keyword, and click the - button.

iPhoto deletes the keyword immediately,
promptingyoufirstif it’s in use, and then
deleting it from all photos that useit.

vV Tip

m@ Ifyou rename a keyword, photos with
that keyword update to match.
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Chapter3

Assigning and
Removing Keywords
Assigning and removing keywordsis
extremely easy.

Figure 3.49 You
can add and

remove keywords
in the Keywords
field under any
photo. iPhoto
autocompletes asTo assign keywordsto photos:
you type, offering

 
Click in the Keywordsfield under any eeewiatewnos!|suggestions ina
photo, and type thefirst few letters of the Aa.) vad menu if there are

. Movie multiple matches.
keyword. iPhoto autocompletesthe rest Ia
of the keyword (Figure 3.49). Press (,] or

to enter another keyword.

@ Select one or more photos, and click a
keyword in the Keywords window or
press a keyword’s single-letter shortcut.

 

To remove keywords from photos:

@ Click a keyword in the Keywordsfield
undera photo, and press(Delete).

@ With photos containing a particular Figure 3.50 Remove a keyword from multiple photos
keyword selected, switch to the Keywords at once by selecting them andclicking the highlighted
windowandclick the desired keyword keyword in the Keywords wirdow.
(which should be highlighted) to remove
it from the selected photos (Figure 3.50).

VY Tips

@ The single-letter shortcuts arereally
great! | encourage you to use them.

 
Keywordsvs. Albums

Use keywordsfor categories of pictures
that recur throughout your photo collec-
tion. In contrast, use albums for unique

m@ Ifyou press after entering a key- events or categories.
word, iPhoto automatically jumps to
the Keywordsfield of the next photo.* Keywords Do Export!

m Be careful whenselecting photos and
keywordsto avoid assigning the wrong iPhoto '08 and ’09 include keywordsin the
keywordsto the wrong photos. You can IPTC metadata in JPEG or TIFF files when
always choose Undo((Gma)Z)) from the exporting. This means tat work you do
Edit menuifyou makea mistake. in applying keywords won't belost if you

switch to another program.
@ Keywords are alwayslisted alphabetically

in the Keywords window. To export keywords with photos, make
sure to use the JPEG or TIFF format and

select the Include Titles and Keywords
checkboxin the File Export dialog. See
“ExportingFiles,” on page 152.
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Click to The Xindi- Click to inihide and catesthat hide these H iding Photos
unhide aphotois hidden ‘ z ;
photos. hidden. photos, iPhoto can hide photos that you don’t want

to see when working, but which are worth
keeping overall.

 

To hide a photo:

¢@ Select a photo andclick the Hide button,
choose Hide Photo from the Photos menu

((Cmd{L}), or (Contro!)-click the photo and
choose Hide Photo.

iPhoto puts an orange X by the upper-
right cornerofthe selected photo's
thumbnail (Figure 3.51) and, if Hidden
Photosis deselected in the View menu

((CmaShift[H)), makes the photo disappear.

To unhide a hidden photo:

 
Figure 3.51 Hidden photos have an orange X next to
the upper-right cornerof their thumbnails, as you can
see in the top row.
 

@ Make sure Hidden Photosis selected

in the View menu,select a photo and
click the Unhide button, choose Unhide

Photo from the Photos menu((Cma)L)),
or (Control}-click the photo and choose
Unhide Photo.

iPhoto removesthe orange X from the
selected photo's thumbnail, and the photo
displays normally.

 
Figure 3.52 Clicking Hide Hidden Photosat the upper
right makes the hidden photos disappear from view
and causes “Hide x Hidden Photos” to change to
“Show x Hidden Photos,” as in this screenshot. To hide and show hidden photos:

@ From the View menu, choose Hidden

Photos ((Cma)ShiftH)). When Hidden
Photosis selected, hidden photosarevis-
ible, though marked with an X. Whenitis
deselected, hidden photos don’t appear.

@ Whenthedisplay pane is showing an
event that contains hidden photos,click
the “Show x Hidden Photos”text that

appears in the upper-right cornerof
iPhoto’s window (Figure 3.52) or in the
eventtitle's line in Photosview.

Hiding Multiple Photos

You can, ofcourse, hide and unhide

multiple photosat once by selecting more
than one photobeforeyouclick Hide or
Unhide.I wrote the instructions to the

right as | did because the namesofall the
menus changeto plural, and the writing
became too awkward.
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That text changes to “Hide x Hidden
Photos” whenthey're showing
(Figure 3.51); click it again to make
those photos disappear from view.
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Chapter 3

Flagging Photos
iPhoto can flag photos that you want to work
with temporarily. Flagging is muchlike using
the checkmark keyword, but iPhoto provides
a few specific features for flagged photos.

To flag a photo:

@ Select a photo andclick the Flag button
on thetoolbar or choose Flag Photo from
the Photos menu((CmdJ.)).

iPhoto puts an orangeflag icon by the
upper-left corner of the selected photo's
thumbnail (Figure 3.53), and the photo
appearsin the Flagged album in the
Recentlist (Figure 3.54).

To unflag a flagged photo:

@ Select a flagged photo and click the
Unflag button or choose Unflag Photo
from the Photos menu ((CmdJ.)).

iPhoto removesthe orangeflag icon from
the photo’s thumbnail, and the photo
disappears from the Flagged album.

V Tips

@ Youcan make a new eventfrom your
flagged photos. Choose Create Event from
Flagged Photos from the Events menu.
This removes the photos from their
current events and creates a new one.

m You canalso add flagged photos to
anotherevent, which could be an easy
way to merge photos from widely sepa-
rated events.Select the event you want
to contain the photos and choose Add
Flagged Photosto Selected Event from
the Events menu.

m For those of us who remember(Cmd]_.] as
the universal “stop everything” keyboard
shortcut from ancientversionsofthe

MacOS,havingit assigned to Flag Photo
feels very odd.
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Flagged photos Click to Theflag icon
appearin the flag and indicates a
Flagged album—unflag photo has
automatically. been flagged.

   
 anaes 

Figure 3.53 Flagged photos have an orangeflag icon
next to the upper-left corner of their thumbnails, as
you can see above.
 

 
Figure 3.54 Flagged photos automatically appearin
the Flagged album in the Recentlist.
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Figure 3.55 Here I’ve searched for the words “Rick
running” and iPhoto has displayed all those photos
that have either of those words associated with them.

Display and Select

Whenyou perform any search, iPhoto
displays only the results of the search,
whichis helpful for working with the
found photos. But whatifyou wantto see
photos in the sameeventas one of the
found photos? Follow thesesteps:

1. Performasearchor otherwise display
a subset ofphotos.

2. Select a photo in the event you want to
see.

3. Click Events in the source pane.

iPhoto switches back to Events view,
scrolled such that the event contain-

ing the selected photois visible and
selected.

Note that this works (almost) no matter

how you've arrived at a subset ofphotos,
whetherfrom viewing photosassoci-
ated with a person orplace, photos in an
album or smart album, and even photos
in a calendar. Oddly, it doesn’t currently
work whenviewing photosin a book,
card,or slideshow,I’ve reportedit as a bug
to Apple.
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Organizing Photos

Searching with
the Search Field

For quick searches,use the Searchfield
that’s always showingat the bottom of the
window in organize mode. The Searchfield
finds matchesin phototitles, descriptions,
keywords,eventtitles, face names, and loca-
tions. It’s not as granular as a keyword search
(searching for “Jen” finds not only pictures of
mysister, but also pictures she sent me, and
pictures of a friend namedJennifer).

To search for photos
using the Searchfield:

@ Type one or more wordsinto the Search
field.

iPhoto displays all those photos that in
some wayare associated with all the
words you typed (Figure 3.55).

Waysto clear the Searchfield:

@ Click the X button in the Searchfield.

* Switch to any other item in the source
pane.

V Tips

m The waysto clear a search and show
all photos apply to each ofthe specific
searches discussed next,too.

m Searches take place in the current event,
current album,or the currently selected
set of photos, This can cause confusion,
since a search youre sure should work
will fail ifthe wrong photosare selected.

@ Searches are not case-sensitive.

m™ As you type more words, your search
becomes ever more narrow.

m@ iPhoto is happy to search for word frag-
ments, so whenI search for “Rick”, iPhoto

also finds pictures of “Jim Derick”.

57

G1314HOYVASFHLHLIMONIHDNVAS



69

SEARCHINGBYDATE

Chapter3

Searching by Date
iPhoto’s search-by-date feature makesit easy
to display just photos within certain date
ranges, The tasks explained below take place
in the Date toal; to openit, click the Search

field's magnifying glass, whichis actually a
pop-up menu, and chooseDate.

To changetheDatetool’s view:

¢ To switch to yearview, click the view
triangle so it points right (Figure 3.56).

¢ Toswitch to monthview,click the view

triangleso it pointsleft (Figure 3.57).

@ To display earlier or later monthsor years,
click the left or right arrows.

To search for

photosusingthe Datetool:

@ Select the days or months correspond-

ing to the time period in which you want
to find photos. You can(Shift)-click or
(Cma)-click to select multiple contiguous
or non-contiguousdates.

@ Click a monthor year headingto selectall
the days or monthswithin.

vV Tips

@ Searches take place in the current event,
current album,or the currently selected
set of photos.

@ Pay attention to whether a month or day
is bright whiteor light gray. White dates
contain photos; gray dates do not.

m@ The Date tool disappears ifyou move the
pointer outof it. To bring it back, click
anywherein the Searchfield.

m Althoughthe selected dates appear in the
Search field, you can't type dates there.
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Figure 3.56 Here, in year view, I’ve
searched for photos taken in January
2007 and February 2007.

Click to
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Figure 3.57 Here, in month view,
I've searched for photos taken over
Valentine’s Day weekend in 2004.
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Figure 3.58 Here I’ve searchedforall the photosin
my Library that have both the “Tristan” keyword and
the “Tonya” keyword.

 
  

Figure 3.59 Here I’ve done a more complex search,
asking iPhoto to find those photoswith the “Tonya”
keyword but not the “Adam” keyword.
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Searching by Keyword
Ifyou've assigned keywordsto your photos,
they can makeit easy to find the photos
associated with certain keywords.

To search for photos by keyword:

1.

is

In the Searchfield, open the Keyword tool
by clicking the magnifying glass, which
is actually a pop-up menu,and choosing
Keyword.

Click one or more keywords.

iPhoto displays all those photos that have
all the selected keywords(Figure 3.58).
The more keywordsyouselect, the nar-
rower your search becomes, and the fewer
photoswill match. This is an AND search.

To perform an ORsearch:
Ca In step 2 above, instead ofjust clicking

keywords,(Shift)-click one or more key-
words whoseassociated photos you want
to addto theresults.

iPhoto displaysall those photos that
contain anyof the selected keywords.

To perform a NOT search:
Sd

In step 2 above, instead ofjust clicking
keywords,(Option)-click one or more key-
words whoseassociated photos you want
to avoid finding.
iPhoto removesfrom theset of found

photos those with the [Option)-clicked
keyword(s) (Figure 3.59).

V Tips

Althoughthe selected keywords(and the
search logic) appearin the Search field,
you can't type search phrasesthere.

Searchestake place in the current event,
current album,or the currently selected
set of photos.
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Chapter 3

Searching by Rating
You can also search for photos with specific
ratings, much as you searchfor dates and
keywords,

To search for photosvia rating:

1. In the Searchfield,click the magnifying
glass, whichis actually a pop-up menu,
and choose Rating.

2. Click the star correspondingto atleast
the rating of photos you wishtofind.

iPhoto displays all those photos that
havethe selected rating or a higher rating
(Figure 3.60).

V Tips

m@ You mayfind iPhoto's approachoffinding
photos with at least the selected rating
confusing. This means that when you
click onestar, you're actually finding pho-
tos with 1, 2, 3, 4, or 5 stars.Ifyou click 3
stars, you're finding photos with 3, 4, or 5
stars. And ifyou click 5 stars, you're find-
ing only those photoswith5stars, since
there's nothing higher (Figure 3.61). If
this bothers you, work aroundit by creat-
ing smart albumsthatfind exactly the
numberofstars you want.

m@ Searchestake placein the current event,
current album,or the currently selected
set of photos.
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Figure 3.60 Here I’ve searched for 4-star photos and
iPhoto has displayed all those photos that have 4 or

Figure 3.61 Notice how, in each of these ratings
searches, the numberof found photos goes up as
the minimum numberstars a photos must have goes
down.
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Figure 3.62 The Information dialog provides much the
sameinformation as the Information pane, but adds
both a location field and a map showingthelocation.

Information
pane,with Title,
Date, Time,

Rating, Keyword,
Kind, Size, and
Descriptionfields.

Click to display —
the Information
dialog.

 
Figure 3.63 iPhoto’s Information pane displays some
basic information about selected photos.

Using the Information Dialog

As you've noticed throughoutthis
chapter, the Information dialog helps
you modify thetitle, rating, location, and
description for one or more photos.

You can also cycle through photos using
the left and right arrow keys,ortheleft
and right buttons.

Whenyou'refinished viewing or changing
photo information,click the Done button
to dismiss the pop-up.
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Organizing Photos

Viewing Basic
Photo Information

iPhoto presents basic information about
photosin twoplaces: the new Information
dialog andthe old Information pane.

To view info in the Information dialog:
¢ Select one or more photos and choose

GetInfo ((Cma{1)) from the File menu.

Move your mousepointer over a photo
and click the little i button that appears

in the lowerright cornerof the photo
thumbnail. (See it in Figure 3.63.)

iPhoto displays the Information dialog
(Figure 3.62).

To view info in the Information pane:
Sd If the Information paneis hidden,click

the Information button underneath the

source paneto display the Information
pane (Figure 3.63).

V Tips

Both the Information dialog and pane
can display information about multiple
selected photosas well, but only the
Information dialog can changetheinfor-
mation for multiple selected photos.

The Information panelacks location
informationentirely. It’s essentially a
holdoverfrom iPhoto 1.0.

Apple expects users to modify most
photo information with the Information
dialog, new in iPhoto ‘09.In particular,it’s
how you assign location information to
photosthat lack geotags. See Chapter5,
“Working with Places,” which begins on
page 71.

Oddly, you can’t change the time and date
of a photo in the Informationdialog.

61

NOILVWUOIN|OLOHJISVGDNIMAIA



73

VIEWINGEXTENDEDPHOTOINFORMATION

Chapter 3

Viewing Extended
Photo Information

To see more information than the

Information dialog and the Information pane
display, use the Extended Photo Info window.

To view information in the

Extended Photo Info window:

1. Select a photo and choose Show
Extended Photo Info from the Photos

menu((CmdOption|(1)).

iPhoto displays the Extended Photo Info
window(Figure 3.64).

2. Ifnecessary, click an expansion triangle
to reveal Image,File, Location, Camera,or
Exposure information.

V Tips

m When the Extended Photo Info window

is showing, you can click another photo
to see its information immediately.

m The Extended Photo Info window,unlike

the Information dialog and Information
pane,is entirely read-only—you can’t
change anythingin it.

@ Location information in the Extended

Photo Info window can comeeither

from a camera or via manualentry. See
Chapter5, “Working with Places,” which
begins on page 71.

m The Extended Photo Info window

picks up its information from the EXIF

(Exchangeable ImageFile) data stored by
mostdigital cameras. EX/F is an industry
standard that’s designed to help interop-
erability among cameras, printers, and
other imaging devices.
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Width: 2,448pixels

Height: 3,264 pixels

Original Date: 7/6/200811:57:41 AM
Digitized Date: 7/6/2008 11:57:41 AM
ait

Name: IMG_1744JPG
Size: 2.4 MB

Modified: 12/31/2000 7:00:00:PM

imported: 11/23/2008 3:03:38 PM
Location

GPS Latitude: 40.030998" N

GPS Longitude: 75.391273" W

GPS Altitude: —
Place: Chanticleer Garden

Wayne

Delaware

Pennsylvania
United States

Camera

Maker: Canon

Model: Canon PowerShot $0870 IS

Software: QuickTime7.5

celehqiit

Shutter: 1/125

Aperture: f/2.8

MaxAperture: f/2.8

Exposure Bias: 0.00

Exposure: —

Exposure Index: —

Focal Length: 4,6mm
Distance: —

Sensing: One-chipcolor area

Light Source: —

Flash: Off

Metering: Pattern

Brightness: —

ISOSpeed: 50

Figure 3.64 The Extended Photo Info window pro-
vides detailed information that was recorded about

the image by the camera.
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WORKING  
WITH FACES

Sad Faces

As muchas] find Faces utterly magical
andtruly addictive,it isn’t perfect, as
you'll find out. It sometimes doesn’t see
faces in photos,andit can, particularly
beforeit’s fully trained, identify people
incorrectly. Faces can recognize some
people, like my brother-in-law,after only
minimal training, whereasit fails miser-
ably to recognize otherpeople, like my
sister, no matter how manytimesI| iden-
tify her in a photo.

AlthoughI have noinside information,
I fully expect that Apple will be improv-
ing iPhoto’s face detection and recogni-
tion capabilities in future updates to the
program.So evenifthe feature has some
quirks now,it will only be improving as
time goesby.

74

The most important addition to iPhoto ‘09 is
Faces, which can detect faces in photos and,
after you've trainedit by identifying a person
in a numberofphotos, automatically recog-
nize that person’s face in other photos.

Faces is importantfor two reasons.First, as
ourdigital photo collections grow—I have
about 17,000 photosright now, and many
people have far more—it becomes ever more
difficult to find any given photo. That’s not
because iPhoto’'s searchtools are bad, but

because adding keywordsor other metadata
takes time manyofus don’t have. With a
little effort spent training Faces, you can reap
the benefits of having useful metadata auto-
matically applied to manyofyour photos.

Second,from a historical standpoint, photos
that don’t identify at least the people in
them (and,ideally, also the place and event
at which the photos were taken) are nearly
worthless. Just recently, my mother had to
ask my grandmotherto identify some people
in an ancient family photo, since no one had
thought to write names on the back. You
may know whothe people in your photos
are, but will your children or grandchildren?

One warning. Many peoplefind training
Faces to be addictive, so you may wish to set
aside sometimeto do it when you don’t have
anything more importantto do.
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THEFACESOFFACES

Chapter 4

The Facesof Faces

Unlike mostof iPhoto’s other modes, Faces

offers a numberofdifferent views, depending
on whether you're namingfaces, browsing
through identified faces, or training iPhoto to
recognizeaface.

Subsequent pagesin this chapter explain
these features in moredetail.

To namefaces:

# Whenever you're viewing a group of
photos (not events!), select a photo and
click the Name buttonat theleft side of

the toolbar.

iPhoto magnifies the photo and displays
a namelozenge underanyfaces it has
detected (Figure 4.1),

To browsefaces:

@ Click Faces in the source paneto display
the Faces corkboard, which shows a

snapshotfor each person you've named
(Figure 4.2).

@ Inthe Faces corkboard, double-click a

person’s snapshotto display all the pho-
tos that have been identified as contain-

ing that person (Figure 4.3).

To train Faces:

@ Double-click a snapshot in the Faces
corkboard,and,if there are any photos
shownbelow the “So-and-so may also
be in the photos below’bar, click the
Confirm Namebuttonin the toolbar.

iPhoto switches from merely display-
ing the photosto letting you click them
to confirm whetheror not the person
appears in the photos (Figure 4.4).

V Tip

@ You can drag snapshots on the corkboard
aroundto rearrange them.
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Figure 4.1 In naming view, iPhoto displays a name
lozenge underany facesit has identified.
 

 
Figure 4.2 Click Faces in the source paneto display
the Faces corkboard.
 

 
Figure 4.3 Double-click any face in the Faces cork-
board to displayall of that person’s identified photos.
 

 
Figure 4.4 Clicking the Confirm Name button switches
you into training mode.
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Figure 4.5 When iPhoto thinks it recognizes a face,
click the checkmark button to accept the suggestion
or the X buttonto rejectit.

 
Figure 4.6 When iPhoto can only identify that a face is
unknownface, enter a name in the name balloon.

 
Figure 4.7 If iPhoto doesn’t even identify a face, use
the Add Missing Face button to adda face rectangle.

Navigating while Naming

You mayfindit easiest to assign names to
faces in a lot ofphotos at once. To do this
easily, click the arrow buttons to move to
the next or previous photo, orjust use the
arrow keys.
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Working with Faces

Putting a Name to a Face
iPhoto can identify faces, but until you've
assigned a nameto a face andtrained iPhoto
to recognize thatface (see the next page),
iPhoto won't be able to recognize that face
in the future automatically.

Toget started, select a photo containing at
least one face andclick the Namebuttonin

the toolbar. Then use one of the following
approaches.

To assign a nameto a face:

@ IfiPhoto thinksit recognizes a face in
the photo,click the checkmark button to
accept the suggestion or the X button to
reject it (Figure 4.5).

@ IfiPhoto hasonly identified that an
unnamedface exists in the photo,click
the nameballoon, enter the person’s
name, and press (Figure 4.6).

@ IfiPhoto hasn't identified a face, click the

Add Missing Face button,center the rect-
angle on the face andresizeit, click Done,
and enter the person's name(Figure4.7).

V Tips

@ iPhoto attempts to autocomplete as you
type, as you can see in Figure 4.6. Use
the arrow keys and or the mouse
to select suggested names(which can
comefrom entries in Address Book), or

just keep typing to enter a new name.

m@ IfiPhoto identifies multiple faces in a
photo,press to move among them.

m You can assign names to faces whenever
the Name button appearsin the toolbar.
When you're browsing throughfaces (and
have a Confirm Name buttoninstead),

magnify a selected photo by pressing
or (m), at which point the Name

button appears again.
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TRAININGFACERECOGNITION

Chapter 4

Training Face Recognition
Although you can navigate through photos
fairly quickly while adding names, iPhoto
provides a muchfaster way of training the
face recognition technology.

To train face recognition:

1. Click Faces in the source pane, and then
double-click the snapshotofa person
for whom you wantto improve iPhoto's
recognition.

iPhoto shows photos to which you've
already assigned the person's name.Ifit
thinks the person’s faceis also in other
photos,it displays them below the bar
and enables the Confirm Namebutton

(Figure 4.8).

2. Click the Confirm Name buttonin the

toolbar.

iPhoto switches into confirmation mode

(Figure 4.9). Note that iPhoto zooms
each photo to focus on theidentified face,
and adds a Confirm button to each photo.

3. Confirm each photoby clickingit, or
reject it by (Option}-clickingit.

Confirmed photos receive a green name;
rejected photosreceive a red name, pre-
fixed with “Not” (Figure 4.10).

V Tips

m@ Ifyou make a mistake,just click the
photo again to change yourvote.

m@ Instead ofclicking each photo, drag or
(Option|-drag a selection rectangle around
the photos to confirm orreject.

m@ It’s usually fastest to confirm or rejectall
the photos with a drag-select, then click
the few that are incorrect to reverse them.

m When browsing,as in Figure 4.8, you can
switch the view between close-ups and
the full photos with the View control.
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Figure 4.8 Double-click a face in the Faces corkboard
to see all the photos associated with that person.

 
Figure 4.9 Clicking the Confirm Name button switches
you into confirmation mode.

ee eee

" |3 
Figure 4.10 Click the photos to confirm the name,or
Option-click them to reject the name.

No Photos to Confirm?

If iPhoto doesn't find any photosfor you
to confirm, you'll have to locate them
yourself and assign the name manually,
as discussed on the previouspage.
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Figure 4.11 Control-click a mistaken photo and
choose This Is Not “Name” from the contextual menu.

 
Figure 4.12 In confirmation mode,click already-
recognized photosto fix mistaken recognition. 

 
Figure 4.13 When naming photos, you can always
enter anew namefor an incorrectly recognized face.

Should You Identify Everyone?

Ifyou're a completion freaklike me, you'll
probably wantto identify nearly everyone
in your photo collection. Normal people
maywishto identify just family and close
friends. There's no right wayto doit.
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Fixing a Mistaken Face
At somepoint, youre certain to make a
mistake and assign an incorrect name toa
face, or iPhoto may assign a nameto a face
incorrectly despite your training (I haven't
seen this happenyet, but I assume anything
is possible). There are various waysto fix face
recognition mistakes.

Waysto fix a misrecognized face:

# Whenbrowsing through a person's
identified photos (double-click a snap-
shotin the Faces corkboard),(Control)-click
an incorrect photo and chooseThisIs
Not “Name”from the contextual menu

(Figure 4.11).

@ Whenbrowsing througha person'sidenti-
fied photos, select one or more photos
andpress(Delete).

@ Inconfirmation mode, click incorrectly
recognized photosabovethebarto reject
them (Figure 4.12).

# Whenyou're namingfacesin photos,if
you comeacross anincorrect one,just
enter the correct name (Figure 4.13).

Y Tips

@ Wheninconfirmation mode, you can
(Control|-click a suggested face, which
displays a contextual menuwith Confirm,
Reject, and Name items. Choose Name to
enter the correct namefor the suggested
face without leaving confirmation mode.

@ Using whenbrowsing through a
person'sidentified photos does notdelete
the photo,it merely tells iPhoto to disas-
sociate the person’s namewith the photo.

m Removingthelast identified photo from
the collection of photos associated with
a person removestheir name from the
Faces corkboard.
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ADDINGINFOTOPEOPLE

Chapter 4

AddingInfo to People
There are four pieces of information associ-
ated with a person’s snapshotin the Faces
corkboard: the person’s display name,full
name, email address, and a key photo.

Waysto set the display name:

¢@ Inthe Faces corkboard,click the

person's display nameand enter a
new one (Figure 4.14). Or...

1. Inthe Faces corkboard, mouse over a

snapshotandclick its i button,or select it
and chooseGetInfo from the File menu

((CmdJ[1}) to show the Information dialog
(Figure 4.15).

~ Click the display name and enter a new
one.

3. Click Doneto dismissthe dialog.

To set the full name:

@ Inthe Informationdialog, click “full
name’andtypethe person'sfull name
(Figure 4.15). Click Done.

To set the email address:

¢@ Inthe Information dialog, click “email
address” and type the person's email
address (Figure 4.15). Click Done.

Waysto set the key photo:

@ Inthe Faces corkboard, scrub over the

person’s snapshot and whenyousee a
new oneyoulike, press (Spacebar).

@ When browsing through a person’s
photos,(Control]-click the desired photo
and choose Make Key Photo from the
contextual menu.

@ Inthe Information dialog, scrub over
the person’s key photo and whenyousee
oneyoulike,clickit. (The change isn't
reflected until you click Done.)
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Figure 4.14 To change a person's display name,just
click it in the Faces corkboard and enter a new name.

 
Figure 4.15 In the Information dialog, you can change
a person’s display name,full name, email address,
and key photo.

Nameand Email for Facebook

Ifa full namelike “Tonya Engst” is present
in the Informationdialog, iPhoto uses that
for the photo’s tag in Facebookinstead of
the “Tonya” display name. More impor-
tant, Facebook uses the email addressin

the Information dialog to connect a photo
with the profile of the pictured Facebook
user. The email address must match the

person's email address in Facebook(verify
that in the person'sprofile). This is whyit’s
helpful that iPhoto 8.0.2 andlater suggest
nameand email address information from

Address Book. Changes madeto thefull
name and email address arentreflected in

photos already uploaded to Facebook.
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Figure 4.16 With the View control at theleft side of
the toolbar toggledto theleft, you see full photos
when browsing a person’s photosin Faces.

 
Figure 4.17 Click the View control’s right-hand button
and you see only close-ups when browsing a person’s
photosin Faces.

Working with Faces

Faces and Organize Mode
Mostofyourinitial time with Faces will be
spent teaching iPhoto howto recognize your
friends and family. What do you do with
Faces after that’s done?

Theslightly confusing fact about Facesis
that when you're browsinga person’s photos
via the Faces corkboard, you're in organize
mode,with only twoslight differences.

Differences from organize mode:

# When browsing faces, click the View
controls to toggle between showingfull
photos (Figure 4.16) and close-ups
(Figure 4.17).

@ As you take more photos that may
not be recognized automatically, use
the Confirm Namebutton to continue

iPhoto’s training.

v Tips

m Remember, since you're essentially in
organize mode when browsinga person's
photosin Faces, you can use those photos
as the source for photosfor a slideshow,
book, calendar, or Web album.

mM Since Faces can’t identify people who
aren't facing the camera, consider using
keywords that are the same as your
display names and making smart albums
that collect al/ the photos ofa person.
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DELETINGPEOPLEFROMFACES

Chapter 4

Deleting People from Faces
Ifyou've assigned names to people who
appearonly onceor twicein your entire
photolibrary, it may not be worth having
them cluttering your Faces corkboard.It’s
easy to removea person from Faces.

To delete a face:

@ From the Faces corkboard, drag a person's
snapshotto the Trash in the source pane
(Figure 4.18), or select a snapshot and
press (Cmd)[Del}.

iPhoto prompts to makesure youreally
wantto delete the person from Faces
(Figure 4.19).

@ When browsing through a person'sidenti-
fied photos, select all the photos and
press(Delete). Alternatively, (Control)-click
the selection and choose This Is Not

“Name” from the contextual menu.

V Tips

m Whenyouuse the second method above,
iPhoto doesn’t promptyouatall.

@ Deleting a snapshot from the Faces
corkboard removes the name from

photos, but doesnot delete the photos
themselves.

m Rememberthat you can rearrange the
snapshots on the corkboard by dragging
them, makingit less necessary that you
delete little-represented people. I recom-
mendputting your most frequent photo
subjects at the top.
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Figure 4.18 Drag snapshots you don’t want on the
corkboard any moreto the Trash icon in the source
pane.

 

oewhichit appears. Theahotosremain in your library.
[DenteAkAgain

(Cancel) (GDelerefaces)

Figure 4.19 Click Delete Face to confirm that you
really want to delete the person from the Faces cork-
board.
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WORKING  
WITH PLACES

Geotagging with Other Programs

For thoseinterested in geotagging their
photos automatically right now,two pro-
srams, Houdah Software's Houdah Geo
and Ovolab’s Geophoto, promise to match
up a GPStrack log (containing locations
associated with times) recorded with a
special GPS device with the time stamps
on the photos you take. They then write
the latitude and longitude coordinates
into the photos, after which iPhoto can
read them.

| haven't used either program personally,
nor do lowna GPStracklogger, so I can't
comment on how easy they are to use
with iPhoto. The cost of entry is $25-$30
for the software and about $100 for a GPS

track logger that you'd clip on yourbelt
loop or camera bagas you take photos.

For more information about Houdah

Geo,includinga list of recommended
GPStrackloggers, visit Houdah Software
at www. houdah. com/houdahGeo/. To learn

more about Geophoto, check out Ovolab
at www.ovoLab.com/geophoto/.
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A major addition to iPhoto ’09 is Places,
which makesit possible to see where your
photos were taken,find them by location,
and include mapsof the locations in books.

Unfortunately, you can’t train iPhoto to rec-
ognize where a photo wastaken, Geotags—
location information—are either embedded

in a photo’s metadata automatically by the
camera used to take the photo,or they're
somethingyou addlater in iPhoto. (There
is one other way;see the sidebartotheleft.)

Right now,apart from Apple’s iPhone, only
a handful of cameras contain the necessary
GPS (Global Positioning System) chip neces-
sary for a camerato divineits location from
orbiting satellites. So unless you take a lot
of photos with an iPhone, assigning loca-
tion information to photoswill largely be a
manualeffort. Don't worry,it’s not hard.

Note that Places, becauseit relies on maps
from Google and Google searches, requires
an Internet connection.

How obsessive you wish to be when
geotagging your photosis up to you.I'm the
sort ofperson whowill carefully find the
particular beach at Half Moon Bay where a
photo was taken; other people may be happy
to say the photo was taken in Half Moon Bay,
or even just in California.
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THEFACESOFPLACES

Chapter 5

The Facesof Places

Unlike most of the other modesin iPhoto,

Places offers a numberofdifferent views,

depending on whether youre viewing a
photo’s location information, looking at map
showingthelocations of your photos, brows-
ingalist of places, or making a newplace.

To view a photo’s location:

@ Select one or more photos and choose
GetInfo from the File menu ((Cmd\1)), or
click the i button that appears when you
mouse over a photo.

iPhoto displays the Informationdialog,
with a prominent map of the photo'sloca-
tion (Figure 5.1).

To view a mapofphotolocations:

@ Click Places in the source pane and make
sure the World View button (the one with

the globe)is selected in the View control
at theleft side of the toolbar (Figure 5.2).

@ While viewing the Informationdialog for
photos that have geotags,click thelittle
arrow next to Show in Places to jumptoa
zoomed-in map view in Places.

To browsethrough photo locations:

@ Click Places in the source pane and make
sure the Browser View button(it has four

little rectanglesin it) is selected in the
View control in the toolbar.

iPhoto showsthe hierarchical location

browser(Figure 5.3).

To view your custom places:

# From the Window menu, choose Manage
MyPlaces.

iPhoto displays the Edit My Placesdialog,
showingthe custom places youve created
andletting you perform a Google search
to find the location for a new custom

place (Figure5.4).
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Figure 5.1 Photos
with geotags
show maps of
their locations in
the Information

dialog.
 

Figure 5.2 Places can display maps (here of Northern
Wales) with pins showingthe locations where you
took photos.

 
Figure 5.3 Alternatively, you can browse through your
photos by selecting from a hierarchical list of places.

 
 

Figure 5.4 You can make your ownplaces, with their
own names,that you can apply to photos without
geotags, and that will be applied automatically to
photos taken by GPS-equipped cameras within the
radius you set.
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Figure 5.5 Terrain map style showshills and valleys,
along with map borders, place names,and roads.
 

 
Figure 5.6 Satellite map style showsonlysatellite
imagery, making it useful for extreme close-ups. You
can zoomin further in Satellite and Hybrid style than
in Terrain style.
 

 
Cais eo 5

Figure 5.7 Hybrid map style usessatellite imagery but
also overlays it with place and road names, making
it the most usefulof the three views. Like Satellite

style, the Hybrid style can zoom closer thanTerrain.

Select Pin before Zooming

To makesure iPhoto zoomswhere you're
expecting whenusingthesizeslider,
select a pin before zooming.

Showing Photos Onscreen

Working with Maps
Before we dive into howto use Places,it’s

important to understand how to work
with the maps you see, as in Figure 5.1,
Figure 5.2, and Figure 5.4, previous page.

To move the mapview in the window:

@ Click-and-hold anywhere within the map
and drag the map view around. Let up
and repeat to move it more than a screen.

To zoom in and out:

¢@ Inthe main map viewin Places, drag the
size slider to the right to zoom in, and to
the left to zoom out. Alas, you can’t zoom
in all the way with the sizeslider.

¢@ IntheInformation dialog and in the Edit
MyPlacesdialog,click the + and — but-
tons to zoom in andout.

@ Inthe main mapview in Places and in
the Edit My Places dialog, double-click
anywhere in the map to zoom in, and
(Control|-double-click to zoom out.

To change theview style:

Although the buttonstyles vary slightly,
iPhoto's mapinterfaces provide three ways to
view the map:Terrain,Satellite, and Hybrid.

# To view the map in traditional terrain
mapstyle, with map borders, place
names, road names, and othercarto-

graphic marks,click the Terrain button
(Figure5.5).

# To view the map with satellite imagery
sufficient to see buildings at the most
zoomedlevel, but without any carto-
graphic marks, click the Satellite button
(Figure 5.6).

@ To view the mapin with bothsatellite
imagery and cartographic marks,click
the Hybrid button (Figure 5.7).
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GEOTAGGINGPHOTOS

Chapter 5

Geotagging Photos
Photos you take with an iPhoneor other
GPS-equipped camerawill be geotagged
automatically, Forall other photos, you must
add geotags manually.

To geotag photos:

a In the Advanced paneof iPhoto’s
Preferences window, choose

Automatically from the Look up
Places pop-up menu(Figure5.8).

In organize mode,select an event or one
or more photos, and either choose Get
Info from the File menu ((CmaJ1}) or click

the little i button that appears when you
mouse overan event or photo.

iPhoto displays the Information dialog
(Figure 5.9).

Click the location field and enter the

place where the photos were taken.

As you type, iPhoto matches against
its internal databaseofplaces and any
custom places you'vecreated, displaying
a list of locations.

If iPhoto finds the location you want,
click it to select it, and click Done.

If you need to make a new custom place,
see “Adding NewPlaces,” on the next
page.

VY Tips

74

You mustclick found locations to select

them; simply pressing or won't
work.

To removea location from selected

photos, display the Informationdialog,
click in the location field, andclick the X

button that appears atits right side. This
doesn’t remove GPS coordinates stored

by a camera,just the connection with a
place namethat youset previously.
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Importing: h4 Copy items to the iPhoto Library
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the items aro not cooled inte the iPhoto
Library.

RAW Photos: (_) Use RAW when using external editor
(7 Save edits as 16-bit TIFF files 

Figure 5.8 Set whether or not iPhoto should look up
places based on the GPS coordinates in photos taken
with a GPS-equipped camera(like an iPhone).
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Figure 5.9 Type a place nameinto thelocationfield
and, ifiPhoto suggests an appropriate location,click
the namein the drop-downlist to selectit.

Lost?

In theory, events and their photos should
share location information. In practice,
the connection seems weak and chang-
ing an event location may not change
the location of its photos. To increase the
chancesof this working,first remove loca-
tion informationby clicking the X button
at the right side of the location field. Then
reassign locations.

l anticipate this behavior improving in
future updates beyond iPhoto 8.0.2.
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Figure 5.10 Start with a Google search when adding
new places. Once you've founda place,selectit, posi-
tion its blue pin as you want, and click Assign.

Working in My Places

Whatifyou wantto edit the name of a
place or removeit? Click My Places in the
Edit My Places dialog to seealist ofall
your places. Once there, you can double-
click a place’s nameto edit it, or click
the — button next to the nameto delete

the place. iPhoto warns youifthere are
photosassociated with the place before
deletingit.

Places Is Buggy

Honestly, giving exact directions on how
to create and assign new locations has
beendifficult, becauseI’ve run into a
numberofodd and incorrect behaviors

in iPhoto 8.0.1 and 8.0.2. If I can isolate

these,I'll report them as bugs and hope-
fully Apple will fix them. In the meantime,
suffice to say that things may not work
exactly as I've described here.
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Adding New Places
Although iPhoto knows about thousands
of places, you'relikely to want to make your
ownplaces,if only for places like your house.

To add a new place:

1

nag

Choose Manage MyPlaces from the
Window menu,or click New Place when

typing a place namein the location field
(Figure 5.8, previous page).
iPhoto opens the Edit My Places dialog.

Click Google Searchifit’s not already
selected.

Perform a Google searchfor the place you
want tofind.

iPhoto displays a list of possible matches.

If one of the matchesis correct,click it to

select it and turnitspin blue.

If there are no matches,or ifyou wantto
add a completely unsearchable location
(like a trailhead), zoom and pan the map
to the desired spot and click Drop Pin.

Ifyou wantthe location to be more pre-
cise, zoom in, drag the pin to reposition,
and adjust the vicinity by dragging the
control on the right edge of the bluecircle
(Figure 5.10).

If necessary, enter a namefor the place.

Click the Assign or Done button (depend-
ing on yourstarting point in step1).

Vv Tips

Whensearching,be as precise as you can
to get the best results, with a full address
ifyou knowit.

Click the + button next to the selected

location’s nameto addit to the My Places
list. Assigning the location to a photo also
hasthis effect.
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DISPLAYINGPHOTOLOCATIONSONTHEMap

Chapter 5

Displaying Photo
Locations on the Map
There are two basic waysoffinding photos
with geotags: displaying them on iPhoto’s
zoomable map and browsing through a
hierarchicallist of places (next page).

To display photo locations on the map:

@ Click Places in the source paneand,if
necessary, click the World View buttonin
the View controlin the toolbar.

@ Whenin the Information dialog fora
photoor event that contains geotags,
click the arrow next to Show in Places,

iPhoto displays its map zoomed to
display the places in which the selected
photo(s) were taken (Figure 5.11).

Things you can do on the map:

@ Zoom in to see moredetail or out to see

more of the surroundingarea.

@ Switch amongterrain,satellite, and
hybrid styles by clicking their buttons.

@ Drag the map to movethe view within
the window.

# Mouse over a pin andclick the arrow but-
ton in the Namepop-up(Figure 5.12)
to view the photos taken in that location.
Alternatively, click a pin toselectit, and
then click the Show Photos button.

iPhoto displays the photos from that
location in organize mode(Figure 5.13).
Return to the mapviewbyclicking the
Mapbuttonat the top of the display pane.

@ Click the Zoom All button to zoom out to

the point where all your photolocations
can appear on the map.

@ Click the Smart Album button to make

a smart album ofphotos from the pins
visible on the mapat that time.
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Figure 5.11 Click Places to see a map zoomed suffi-
ciently to showall the locations in which your photos
have been taken.

 
Figure 5.12 Mouseovera pin, and click the arrow in
the Name pop-upto view all the photos from that
location.
 

 
Figure 5.13 When viewing photosfrom a location,
you're in organize mode,with all its associated tools.
To return to the map, click the Map button in the
upperleft corner.
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Browser Country State City Location
View button. column. column. column. column.

 

 

Figure 5.14 Click the Browser View button in Places
to use the hierarchical location browserto select

photos.

Figure 5.15 As you select places, starting from the
left, the columnsto the right display only the places
within the selected location.
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Browsing by Place
It may beeasier, particularly after you've
addeda lot ofplaces, to navigate your photos
with iPhoto’s hierarchical location browser.

To browsehierarchically:

1 Click Places in the source pane.

2. Click the Browser View button in the

View controlto display iPhoto’s location
browser(Figure 5.14).

3. Click a place namein anyoneofthe four
columns(country,state, city, location).

iPhoto displays just those photos whose
geotags are within theselected place.

V Tips

@ When you click a place namein one of
the columns, the next column to the

right displays only the places within the
selected place,

In Figure 5.15, because I selected United
States in the first column, the second

column containsonly U.S.states. And
becauseI selected New York in the second

column,the third column contains only
cities in New York. And becauseI selected

Ithaca in the third column,the fourth

columncontainsonly placesin Ithaca.
Realistically, this approachto drilling
down will be necessary only for people
with many different places.

m Whenyou've displayed the photos ina
particular place, via either the hierarchi-
cal browseror the map,you're in orga-
nize mode. See Chapter 3, “Organizing
Photos,” starting on page 29.

@ Youcan also search for place names, and
iPhoto will find all the photos within that
place (see “Searching with the Search
Field,” page 57).
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Chapter 5

Putting Maps in Books
Places provides a major new bookfeature.
In all book themes, a new mappage layout
becomesavailable to show where photosin
the book were taken. The Travel themeoffers

additional map pages and options. To start
making a book (where thesesteps pickup),
see “Creating Books Overview,’ page 172, and
“Designing Book Pages,” page 173.

To put a mapin a Travel book layout:

1. Select a page, and from the Layout pop-
up menu, choose one of the Maplayouts
to insert a map (Figure 5.16).

2. Click the map on the bookpageto display
the map editing pop-up (Figure 5.17).

3. Use the Zoomslider to adjust the zoom
level to show the desired amountof

detail, and drag the map within the frame
to position it appropriately.

4. Entera title for the mapin theTitle field.

5. Deselect places you don't want to appear
on this particular map.

You can also removeplaces from this
map’slist by clicking the — button below
the list. You can also add a new place
that’s not currently associated with the
photos in the book. Click the + button
andfollow the instructions on “Adding
NewPlaces,” page75.

6. To edit the place namesfor this map,
double-click a name and changeit.

7. Ifthe places aren't in the right order, drag
them aroundin thelist to rearrange.

8. Click Show Linesto display lines con-
necting the places, in chronological order.

9, For more optionsrelated to lines,titles,
and other adornments,(Control)-click the
map and choosethe appropriate item
from the contextual menu(Figure 5.18).
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Figure 5.16 You can add map pagesto books, com-
plete with dots for the places the photos were taken,
and lines showing your path between thoseplaces.
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Figure 5.17 The map editing pop-up helps you
zoom the map,giveit a title, and choose which
places appear (and in whatorder). 

Add Place

Move Region Label

v¥ Show Lines

Return to Starting Place
ChangeLine Style

v ShowTitle
v Show Place Marker Text

¥ Show Region Text
wv Show Compass
¥ Include Texture & Shadows

Figure 5.18
Control-click the

map to access
additional

options in the
J contextual menu.

Center Map on Places
Reset Map
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Nondestructive Editing

In thefirst few versions of iPhoto, the

program saved each change as you made
it, which wasa bad idea becausethe lossy
JPEG compression that was applied each
time could degrade the imagequality. In
iPhoto 5, Apple reduced the numberof
times an edited photo would be recom-
pressed by writingall changes out at
once when youclicked Done or moved
to another photo.

In iPhoto 08, Apple switched again,
this time to the nondestructive editing
approach used by Aperture, iPhoto’s high-
endsibling. Since that version,all changes
you make to new photos, or those that
have never been edited in an earlier ver-

sion, are saved in an edit list and applied
to theoriginal. (Previously edited photos
don’t use nondestructive editing unless
youfirst revert to the original photo.) So
in theory, image degradation due to mul-
tiple applications ofJPEG compression
should bea thingofthe past,

iPhotostill maintains the current edited

version of each photo in the Modified
folder; those files are still necessary for
display and export.
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Ifyou're anythinglike me, notall your
photos comeoutperfect. In fact, lots of
them are probably pretty bad, and those
you candelete after import. No harm, no
foul, and you didn't pay for developing.

What aboutthosepictures that are okay,
but not great? Muchofthe time they merely
require a little work. Perhaps you need to
crop out extraneous background thatdis-
tracts the eye from the subject of the photo,
or maybe you wantto removethe red glow
from that cute baby’s eyes(it’s the fault of
the cameraflash, not necessarily the sign of
a demonchild). iPhoto can help with those
tasks and more.

I'm not suggesting that you whip out an
image-editing application, clip your cousin's
ex-husband outof the family reunion photo,
andusefilters that soundlike alien death

rays (Gaussian blur?) to makeit appear as
though he wasneverthere. Ifyou can do
that, great, and iPhotowill even let you use
any other image-editing application, includ-
ing Photoshop and Photoshop Elements. But
for most people, iPhoto providesall the basic
editing tools that they need.

The main thing to rememberis that there’s
no shamein editing photos to improve them.
All the best photographersdoit, and you can
doit, too.
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ENTERINGEpDITMODE

Chapter 6

Entering Edit Mode
Since you canedit in the main window,in
full screen mode,or in another application,
it makes sense that you can enter edit mode
in several ways.

To choose howto edit photos:

1. From the iPhoto application menu,
choose Preferences((Cmd)(,}).

iPhoto opensthe Preferences window.
Click the General button,

2. Select whether double-clicking a photo
edits it (what I'm used to) or magnifiesit.

3. From the Edit Photo pop-up menu,
choose how you wantiPhoto to edit
photos by default (Figure 6.1). To use
another program, choose In Application,
and select a program in the Opendialog
(Figure 6.2).

4. Close iPhoto’s Preferences window.

Waysto enter edit mode:

@ Double-click a photo in any mode
((Option)-double-click in organize mode
ifyou set double-click to magnify), or
double-click a photo twiceifit’s a small

photo on a calendarpage. In organize
mode, you canalso just press (Return).

@ Inorganize mode,click the Full Screen
button or choose Full Screen from the

View menu ((Cmd)(Option|F}) to edit the

selected photosin full screen mode.

¢ (Control|-click a photo in organize mode,
and choose an editing commandfrom
the contextual menu(Figure 6.3). Book
modeoffers a different contextual menu

that also has an Edit Photo command.

V Tip

m@ The capability to edit a photo ina sepa-
rate windowis no longer in iPhoto '09.
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(M4 Check for iPhoto updates auturnatically

  
 

Figure 6.1 In the Preferences window, choose
how you want iPhoto to enter edit mode when
you click the Edit button or double-click a photo.
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Figure 6.2 To use another program, choose In
Application, and then find your desired program
in the Opendialog.

Cut
Copy
Paste

Edit

Edit Using Full Screen
Seerlids

Rotate Clockwise
Rotate Counter Clockwise

Get Info
Shaw File

Show Original File Figure 6.3 Control-click

Batch Change... a photo in organize
Duplicate mode and chooseoneof

the editing commands
My Rating >|from the contextual

Make Key Phota menu. This is a particu-
  

Hide Photo larly good wayto edit in
Mave to Trash an external application
Revert be Original | onanoccasionalbasis.
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v Tips Edit Tools Overview

m@ Hide or show the Thumbnail list at the (Main Window)
top of the window by choosing Hide
or Show ((Gma{Opton|T)) from the View Here's a quick look at the tools available
men's’ Thimnbnail submenu, when you edit an image in the main window

(Figure6.4).
m@ Whenin edit mode, (Control)-click any-

whereon a photo to access the com-
mandsthat appear in the Photos menu.

Images around the
photo being edited The selected image Click Done to save your
appear inthe Thumbnail appears in the display changesto the photo (and
list. Click one to edit it. panefor editing. return to the previous mode).

Click to
switch to

full screen
mode.

Click to hide
or show the

Information
pane (now
hidden).

Click to add
an item to
the source
pane.

Click to
rotate the

image
counter-
clockwise.

Option-click
to rotate
clockwise.

 
 

Size slider.

Adjustthis
Slider to zoom

in and out of
the picture in
the display
pane.

 
not

 Use the previ-
ous and next
buttons to

navigate to
the previous
or next photo
in the current7 a —, y

iis, album.

Figure 6.4 Click the Adjust

 
 

button to open
the Adjust win-
dow.

Click to open Click the ,
the croptool. Enhance button Click the Effects

to fix photos button to open the
automatically. Effects window.

Click to open the
straightentool.

To eliminate red-eye in Use the
a picture of a person or Retouch tool
pet, click the Red-Eye to scrub out
button and then click unwanted
the subject’s eyes. blemishes.
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Chapter6

Edit Tools Overview

(Full Screen)
V Tips

m™ Choose Always Show from the

EpitTOOLSOVERVIEW(FULLSCREEN)
Thumbnails submenuin the View

menu to display thumbnailsall the time.
You can also set the thumbnail column

position and numberof columnsin the
Thumbnails submenu.

When youedit a photoin full screen mode,
the editing tools and thumbnails are the
sameas in the main window,butthey
automatically appear and disappearat the
bottom andtop ofthe screen when you move
yourpointer to those locations, and there are m Choose Show Toolbarfrom the View
several other buttons that provide necessary menuto display the toolbarall the time.
features (Figure 6.5).

Effects window. Click
an effect to applyit
to the image.

The selected image
takes over the entire

screen forediting.

Images around the photo being
edited appearin the thumbnail
list. Click one to editit.

Adjust window.
Use the controls

here to modify the
image.

Information win-
dow. Useit to

view information,
and changetitles,
date, and time.

Use the previous
and next buttons

to navigate to the
previous or next
photoin the cur-
rent album.

Navigation win-
dow. Drag the
selection rectangle
to scroll aroundin

the image.
Close button. Click

to leave full screen
mode.

Size slider. Use
this slider to

 
HeHS RS zoom in and

outof the pic-

Click to ture. Opens the
open the Click to Click to Use the nemn
Information open open the Retouch tool ow.
window. the crop straighten to scrub out Click the Effects Click the Adjust

tool. tool. unwanted button to open the button to open the
Cheb ToseKsre een Effects window.—Adjust window.

Click to compare  thecurrentimage Click the To eliminate red-eye ina
this image with counter-clockwise. Enhance button picture of a person orpet,
the next one to Option-click to to fix photos click the Red-Eye button and
the right. rotate clockwise. automatically. then click the subject’s eyes.
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Importing; 4 Copy itemsto the iPhoto Library

{Embed ColorSync profileCotorsync orafies cannot be embeddedif
the Hiems are not copied inte the iPhote
Library.

RAW Photos: [1] Use RAW when usingexternal editor
MA Saveedits as 16-bit TIFF files

Lovk up Places: [Automatically rT 

Figure 6.6 Set your RAW preferencesin the Advanced
paneof the iPhoto Preferences window.

Lossy vs. Lossless Compression

There are two basic ways of compressing a
file so it takes up less space on disk: lossy
andlossless.

With lossy compression, some datais
deleted from thefile, usually in ways that
aren't particularly noticeable but that
always reducethe overall quality. Files
compressed with lossy compression
methodsare usually much smaller than
their originals. Lossy compression meth-
ods workwell with pictures and sound
where data that most people can't see or
hear can be eliminated.

In contrast, lossless compression methods
preserveall the datain the original file
perfectly when compressingit. That’s best
for retaining quality, but means that the
file isn’t nearly as small as it would be with
a lossy method.

Thebasic difference then,is the trade-off

betweensize and quality. For higher qual-
ity, choosefile formats such as TIFF that
use lossless methods ofcompression;for
smallerfiles, stick with file formats such

as JPEG that use lossy compression.

Editing Photos

Editing RAW Files
Somedigital cameras offer the option of
shooting in RAWformat, in which the image
isn't compressedat all. RAW is considered
a ‘digital negative” format thatisn’t to be
modified, which has some implications when
you want to edit a RAW photoin iPhoto.

Useful facts about working with RAW:

# Whenyouedit a RAWfile in iPhoto,a
small RAW badgeappearseither at the
bottom of the display paneor in the
toolbarin full screen view.

¢@ iPhoto offers you the option to save
edited RAW files in TIFF format, which

uses lossless compressionto preserve
all the original detail in the RAWfile.
Normally, iPhoto saves edited files in
JPEG format, which uses lossy compres-
sion, meaning that somedetail is lost on
save. You can change this behaviorin the
Advanced pane of iPhoto’s Preferences
windowbyselecting Save Edits as 16-Bit
TIFF Files (Figure 6.6).

¢@ Ifyou prefer to edit RAW files in an exter-
nal editor like Adobe Photoshop, you can
select Use RAW When Using External
Editor in the Advanced paneof iPhoto’s
Preferences window (Figure 6.6). That
setting overrides iPhoto’s normalprefer-
ences for how you edit photos.

@ Ifyou select an edited RAW photo, the
normal Revert to Original command in
the Photos menu changes to Reprocess
RAW.However,the endresult is the

same—all your changes are thrown away
and youstart again with the original
RAWfile.
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ZOOMINGPHOTOS

Chapter 6

Zooming Photos
It can be helpful to zoom in and out while
editing, particularly when using the Retouch
toolor clicking eyes for red-eye reduction.

To zoom in the main window:

@ With an image showingin the display
panein edit mode,drag the sizeslider to
the right to zoom in (Figure 6.7). The
Navigation window appearsto help you
scroll in the photo. To zoom out, drag the
slider to the left (Figure 6.8).

To zoom in full screen mode:

Drag thesizeslider to the right to zoom
in and to theleft to zoom out. The

Navigation window appearsto help you
scroll around in the photo (Figure 6.9).

V Tips

m On Maclaptopsintroducedin late 2008,
you can use the pinch open andclose
gestures to zoom in and out. Check the
Trackpadpane of System Preferencesfor
little demo movies of how this works.

m@ iPhoto ‘09 removesthe scroll bars when

zoomedin while editing in the display
pane. To navigate in both the display pane
andin full screen view, drag the view rect-
angle aroundin the Navigation window.

m Ifyour mouseor trackball hasascroll
wheel, you can useit to scroll vertically
within a zoomedphoto,evenin full
screen mode. Press while moving
the scroll wheel to scroll horizontally.

m@ On Maclaptopsfrom thelast few years,
you can scroll by dragging twofingers
on the trackpad.It’s a great way to scroll
aroundin photos.
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Figure 6.7 To zoom in ona photo,drag thesize slider
to the right. Here I’ve zoomedin all the way. Move
around in the photo using the Navigation window
that appears (lower right). 
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Figure 6.8 To zoom backout, drag the slider to
the left. Here I’ve zoomed back outto the size that

matches the display pane’s size.

 
Figure 6.9 In full screen mode, use the size slider to
zoom in and out, and navigate around with the tiny
Navigation windowthat appears (lowerright).
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Figure 6.10 Notice how the duplicated photo appears
next to its original and howit has “copy” appended
to its title.

 

About Copies

iPhoto is consistent about whereit places
duplicates; they are always “newer” than
the originals, so they sort to theleft of the
originals ifDescendingis selected in the
View menu’s Sort Photos submenu,or to

the rightifAscending is selected (assum-
ing you'resorting by date,of course).

iPhotois also consistent about append-
ing “copy’to thetitle of duplicate photos,
making them easyto select by searching
for the word “copy”in the Searchfield (for
details, see “Searching with the Search
Field,” on page 57).

If the photo has been edited, iPhoto dupli-
cates boththeoriginal and modifiedfiles,
appending “_2”to their filenames. See
“iPhoto Directory Structure,’ on page 19.
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Duplicating Photos
iPhoto lets you duplicate photos, which can
be useful in a variety of situations.

Reasonsto duplicate a photo:
¢ Ifyou want a photo to appear twice in

a saved slideshow, you must duplicate
the photo and addit to the slideshow
separately.

Ifyou want to crop a head shotout of a
photo,for instance, while keeping the
original photo intact, duplicate the photo
and crop the copy.

Waysto duplicate photos:
+

¢

In any mode,select one or more photos
(not thumbnails!) and from the Photos

menu, choose Duplicate ((CmdJD)).

(Control|-click a photo and choose
Duplicate from the contextual menu.

iPhoto duplicates the photo, append-
ing “copy”to the title of the duplicate
(Figure 6.10).

V Tips

@ The duplicate image shows up next to
the original in the Library, and iPhoto
does not create a new event.

The Last Import album does not show
the duplicated photo.

Ifa specific source (calendar,slideshow,
book,etc.) is selected when you duplicate
a photo,the duplicate is added to that
source too. However the photo won't be
duplicated in any other sources that con-
tain it. Also, as of iPhoto 8.0.2, you must
switch out of a source and backin to see

the duplicate.It’s a bug.

iPhoto duplicates everything about the
original, including keywordsandratings.
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ROTATINGPHOTOS

Chapter 6

Rotating Photos
Ifyou've turned your camera to switch from
landscape view (horizontal) to portrait view
(vertical), you may need to rotate the image
in iPhoto to viewit right side up.

Waysto rotate photos:

¢@ Inorganize or edit mode,to rotate one or
more photosclockwise, select them and
click the Rotate button (Figure 6.11 and
Figure 6.12). To rotate the selected pho-
tos counter-clockwise, hold down

and click the Rotate button.

¢ Inorganize or edit mode, select one
or more photos,(Control-click one, and
choosethe desired rotation direction

from the contextual menu that appears,

¢ Inorganize,edit, or slideshow mode (but
not book mode), select one or more pho-
tos and chooseeither Rotate Clockwise

((Cmd{R}) or Rotate Counter Clockwise
((Cmd)(Option(R)) from the Photos menu.

V Tips

m@ Most cameras automatically rotate the
image, eliminating the needfor Rotate.

m You can changethedirection used by
the Rotate button in iPhoto’s Preferences

window;(Option}-clicking always reverses
the default direction (Figure 6.13).

@ It may be easiest to rotate photos in
batches in organize mode. Shrink the
thumbnail size so you can see a number
ofphotos at once, (Cma)-click the ones
that need rotating clockwise, and click
Rotate. Repeat with any images that
need counter-clockwise rotation, holding
down when you click Rotate.

m On recent MacBooks, you can also rotate
photos with a two-fingered twirl.
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Figure 6.11 Here I’m showing a “before” photo in the
main window;note the Rotate button in the lower left

that I’m clicking.

  che S@N a8ee ed 

Figure 6.12 Here’s the “after” picture that resulted
from clicking the Rotate button.
 

 
  

Sources: ff Show last (aa months album
Mi Show item counts

Double-click photo: @) Edits photo
() Magnifies photo

Rotate: © et e 5

Edit photo: |Usingfull screen wl

Email photos using: | <a Eudora =

Connecting camera opens: { @ iPhoto - 

M check for iPhoto updates automatically

  
Figure 6.13 In the middle of the Preferences window,
select which direction you want iPhoto to rotate pho-

tos by default.
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Selecting Portions
of Photos for Cropping
In iPhoto ‘09, you mustclick the Crop button
before you canselect a portion of the picture
to crop. Before proceeding with the rest of
this page, click the Crop button.

To select part of a photo:

¢ Click outside the default selection rect-

angle and drag to create a new rectangle.
iPhoto darkens the photo outside your

t@#o A’ e@N BS ma dices selection rectangle to help you focus on
7 what you haveselected (Figure 6.14).

 
 

Figure 6.14 To select a portion of a photo, drag to

create a selection rectangle. Moveit by draggingit; o
resize it by dragging an edge or corner. HereI’ve cre-
ated a selection rectangle with no specific proportion
to focus on the peach.

Toresizea selection rectangle, drag one
of the rectangle’s edges or corners.

¢@ To moveyourselection rectangle around,
drag it. You may need to movethe rect-
angleto align it to the edgesof a picture.

@ Toconstrain the selection rectangle to
specific proportions, choose an aspect
ratio from the Constrain pop-up menuin
the constraintool. If you haven't created a
selection rectangle, it will be constrained
whenyoudo;ifyou have onealready,
iPhoto resizes it (Figure 6.15). To remove
a constraint, deselect the checkbox in the

constrain toolor press as you resize
the rectangle.

 
* Toconstrain the selection rectangle to

Figure 6.15 To constrain an imageto specific propor- custom proportions, choose Custom
tions, choose an aspectratio from the Constrain pop- from the Constrain pop-up menu, and
up menu inthe constrain tool (in this screenshot I’ve enter the desired aspect ratio helore you
chosen 4 x 6, which will make a goodprint). You can
move and resize the selection rectangle while main- start selecting (Figure 6.16).
taining the selected aspectratio. . . .

= P @ Toswitchthe orientation of the selec-

" — Landscapeor Constrain as Portrait from
Figure 6.16 To constrain an image to custom propor-
tions, choose Custom from the Constrain pop-up the Constrain pop-up menu.
menu, and then enter your proportions in the fields
to the right. The next two pages have more details about

aspectratios and cropping.
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SPECIFICASPECTRATIOS

Chapter6

Specific Aspect Ratios
Ifyou wantto order prints of a photo, you
first should cropit to the appropriate aspect
ratio (Figure 6.17). See the next page
to learn about cropping photos and see
“Understanding Aspect Ratios,” on pages 186
and 187, for more details about aspectratios.

Uses for specific aspectratios:

# Use 1920 x 1200 (Display) before you crop
the imagefor use as a Desktoppicture.
These numbersare specific to your moni-
tor's resolution.

@ Use 4x 3(DVD) or 16x 9(HD)fora land-

scape image for a DVDslideshowcreated
with iDVD.

@ Use Square when you want a square
selection; I've foundit helpful for making
headshot imagesfor use on the Web.

@ Use a custom ratio if some externaluse,

such as a Web page,calls for a specific
aspect ratio.

V Tips

m@ iPhoto assumes you wantto crop in the
sameorientation as the photo, but you
can change that by choosing Constrain as
Landscapeor Constrain as Portrait from
the Constrain pop-up menu.

m iPhoto has some duplicate aspectratios,
presumably for people who don't real-
ize that aspect ratios are ratios between
numbers and multiplying those numbers
by somevalue doesn’t changetheratio.

@ Don'tbother cropping for books, cards,
calendars, and printing on your own
printer;it’s better to use the zoom and
center feature instead becauseit doesn't

modify the original image the way crop-
ping does. See “Editing Photos on Pages,”
on page 176.
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1920 x 1200 (Display)

¥ 2272 x 1704 (Original)
2x3 (iPhone)
3x5

4x3 (DVD)

 4x 3 (Book)

4x6 (Postcard)
5x? (L, 2L)
8x 10

16x39 (HD)
16 x 20

20 x 30 (Poster)

Square
Custom...

Constrain as landscape
Constrain as portrait

 Figure 6.17 Before
cropping, choose
the aspect ratio
that matches your
intended use.
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Figure 6.18 To crop an image,click the Crop button,
select the desired portion, and then click the Apply
button in the constrain tool. Here I’ve cropped outall
the irrelevant background aroundthe insect.

See Sees m1 sie

 
 

 

Figure 6.19 As you can see, cropping this image
improves it immensely.

Adjust Shooting Style

Whentakingpictures, you usually want
to fill the frame with the scene, butifyou
plan to orderprintsofall your photos,
you might wantto includea little extra
space on the edgesto allow for cropping
to a print aspect ratio. For moretips, see

Appendix B, “Taking Better Photos,” start-
ing on page 209.
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Editing Photos

Cropping Photos
Ifyou plan to ordera print of a photo or
display it on your Desktop, you should cropit
using an appropriate aspectratio. Even ifyou
don't plan to print a photo, cropping extrane-
ous detail can improve an image. For more
information, see “Understanding Aspect
Ratios,” starting on page 202.

To crop a photo:

1.

¥

“

Click the Crop buttonorpress(c¢}to
display the crop tool andaselection rect-
angle.

Select the desired portion of the image,
using a constrain setting ifyou plan to
use the imagefor display or printing. See
the previous two pages for moredetails.

Click the Apply button in the constrain
tool.

iPhoto deletes the darkenedarea of the

picture (Figure 6.18 and Figure 6.19).

VY Tips

Press and release to toggle between
the “before” and “after” views.

Ifyourselection rectangle is very close to
one of the standard aspectratios, it’s best
to use the standard aspect ratio in case
you wantto print the imagelater.

Whenyou crop a photo, you remove
pixels from it. So if you were to crop a
1600 x 1200 pixel photo (1,920,000 pixels)
down to 1200 x 900 (1,080,000 pixels),
you've removed almosthalf the image.
Thus,ifyou printthe original and the
cropped version at the same size, the

original will be of a muchhigherquality.
Heavy croppingis one reason why iPhoto
may show a low-resolution warning icon
whenyou're creating booksor prints. For
details, see “Understanding Resolution,”
starting on page 204.
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